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Introduction 

The MCID™ Elite three-dimensional reconstruction module (M3D™) is suitable for 
many applications requiring the reconstruction of a series of consecutive sections as 3D 
models.  Examples of these applications include: 

• Light microscopy 

• Electron microscopy 

• Showing electrode tracks, lesions, infarcts, and other features within brain 
sections 

• Reconstructing PET, CT, or MRI sections 

• Showing patterns of receptor binding in 3D 

One of the most important features of 3D reconstruction is the conversion of 2D data into 
a 3D image by a process called “rendering”.  M3D has a unique and highly efficient 
rendering algorithm that lets users visualize their data at interactive speeds, using the host 
central processing unit.  A powerful host computer (e.g., a Pentium® III or IV) with at least 
256 MB of memory is recommended for 3D reconstruction.  Rendering of very large data 
sets benefits from 512 MB of memory or more.   

Images, Image Stacks and Rendering 
Scientific images often show the internal structures of opaque objects. This is usually 
achieved by staining or labeling to reveal anatomical or physiological details.  For 
example, you might want to look at cellular damage caused by an infarct, or glucose 
uptake in different regions of brain tissue.  Because internal structure is not visible from 
surface views, these structural images must be made from thin sections taken through the 
specimen.  A thin section may show internal structures, functional data (or a combination 
of both), but it lacks any cues that help you perceive depth and 3 dimensional shape. 

In biological sciences, 3D image analysis is usually accomplished using sections of 
opaque objects (e.g., histological sections, tomographic sections).  We can make accurate 
2D measurements from sections, and we can use a series of consecutive sections through 
an object to measure its volume.  However, understanding the arrangement of features in 
three-dimensional structures is not easy using sequential 2D sections. Sectioning interferes 
with our ability to perceive depth, and it is difficult to deduce and communicate the 
original 3D structure of a sectioned object.  

Three-dimensional reconstruction of thin sections, taken at different levels within an 
object, re-creates the perception of a 3D object.  As a first step in 3D reconstruction, we 
arrange the serial sections in a “stack.” A stack is a set of concentric sections, lying in a 
plane defined by the same XY co-ordinates, varying in the depth (Z) dimension. We know 
the X, Y and Z co-ordinates of each point within the stack, so we can use this information 
to reconstruct and display a model of the original object.  
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Three dimensional reconstruction is a two stage process: 

1. Constructing a 3D model from a number of consecutive, thin sections called a 
“stack”. 

2. Converting the 3D model into a 2D image. 

In a good reconstruction, the final image shows us a realistic 3D representation of the 
original object, containing features from the stack and clues to depth, shape and 
orientation. 

Note: Some textbooks use the terms rendering, 3 Dimensional rendering, or 3D 
rendering to describe the reconstruction procedure.  

Aligning, Unwarping and Normalizing Images 
Instruments that create optical or tomographic sections produce image stacks that are 
aligned in the X and Y dimensions.  For example, a microscope can make optical sections 
by focusing at different focal planes within a sample.  At each focal plane, the images 
remain aligned with the microscope’s optical axis. 

On the other hand, physical sections of tissues are not inherently pre-aligned. Stained 
sections, autoradiographs, and other physically sectioned specimens need alignment before 
model construction and subsequent rendering.  Through the history of microtechnique, 
many methods have been proposed to provide internal reference points (or fiducial points) 
for the alignment of physically sectioned specimens (Barden, 1901, Burston and Thurley 
1957, Deverell and Whimster 1989, Dixon and Howarth 1957, Gough 1967, Heard 1931, 
Heard et al., 1991, Yaegashi, Takahashi and Kawasaki, 1987).  Even if intra-specimen 
reference points exist within a stack, few rendering systems are equipped to use these 
references for alignment.  

M3D has a set of functions for section alignment.  This includes moving an image 
manually until fiducial points or borders map a reference section, or computer-calculated 
alignment using fiducial points, contours and grayscale information from within the 
sections.  

After the images are aligned, problems can still exist with localized artifacts such as air 
bubbles, folds or tears.  M3D image editing functions can remove many of these artifacts.  
For example, if you wanted to replace an air bubble trapped in a section, you could use the 
Copy function in the MCID Elite Transform window to select a group of similar density 
pixels nearby, then copy these as a patch to cover it. 

Warps 

Tissue sections often show compression or stretching distortions, sometimes called 
“warps”.  Warps can affect the image in two ways: 

1. The simplest warp is a homogeneous alteration in the size or aspect ratio of a 
section.  For example, microtomy results in compression of sections in the plane 
of the cut.  This sort of simple warping is easily corrected using an unwarping 
algorithm that operates uniformly across the entire section (e.g. Jones, Milthorpe 
and Howlett, 1994).  
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2. A more difficult case arises when the warps vary from point to point within and 
between each 2D image.  This is most likely to occur if the sections are stretched 
as they are mounted on slides. Removing these warps requires functions that 
perform locally variable image stretching and compression.  M3D includes 
general and localized methods of warp removal (image registration in the 
Transform operational window). 

Normalizing 

Images need to be normalized to account for differences in background densities and in 
calibrations. This is especially true of microscope images taken from serial sections. 
Variations in thickness may exist between sections, even within a single section the 
material may not be consistent in different regions. This causes variations in background 
intensity that will affect reconstruction. M3D has routines for normalizing backgrounds 
and calibrations. 

Segmentation 
Any stack of images contains features of interest and backgrounds.  We want to examine 
the features and make the backgrounds transparent, or at least, semi-transparent.  In 3D 
rendering, as in other forms of image analysis, we have to segment the stack of images to 
discriminate between relevant and irrelevant image data.  We can segment features from 
background by tracing around them manually, or by using automatic detection techniques. 

M3D provides a set of tools for performing segmentation prior to creating a 3D object 
from the segmented data.  This process of segmentation and 3D object creation is called 
"geometric modeling".  It is similar to the type of modeling seen on standard 3D computer 
graphics systems; the difference being that anatomical data exist within biological 
specimens and are taken from there.  In a standard computer graphics application, the 3D 
object is created from drawings. 

M3D can discriminate features automatically within a 3D dataset using density thresholds.  
The process of extracting features from a 3D data set is called “volume modeling”.  The 
critical difference between geometric and volume modeling is the way that the features are 
presented.  In geometric modeling, we segment features within a 2D dataset by defining 
their boundaries.  In volume modeling, we segment features within a 3D dataset using 
density information.  M3D performs both geometric and volume modeling (explained in 
more detail, below). 

3D Modeling 
3D modeling describes the interpolation of the stack and it is a critical step in volume 
rendering.  In M3D, the 3D dataset is represented as cubic voxels. Each voxel contains 
two types of information: 

1. Density information (the original density) 

2. Structural information (the structure to which this voxel belongs) 
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Figure 1: Interpolation between serial sections.  M3D applies a linear intensity 
interpolation to create the missing pixels between these sections. 

 

   

Figure 2: The pixels shown in the sections become cubic voxels in a 3D representation. 

 

M3D calculates voxel density values by linear interpolation of the voxels from adjacent 
sections. To calculate structural data, M3D uses a unique volume interpolation algorithm, 
the effect of which is illustrated in Figure 3 and 4. 
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Figure 3: Test images created using MCID Elite graphics tools.  This image is 
interpolated in the next figure to show the effects of the M3D interpolation algorithm. 

 
Figure 4: Interpolation of the structures shown in Figure 3.  The white skeleton cube 
shows the outlines of the dataset.  Note the Rotation Cube at lower right showing the 
present orientation of the rendering. 

 

Types of Rendering 
M3D has four categories of rendering: 

• Contour rendering 

• Surface rendering 

• Density rendering 

• Combined Surface/Density rendering 

Each method produces different results when applied to a dataset, so the number of 
possible renderings is very large indeed. 
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Contour Rendering 

On a map, contours define points lying at the same height above sea level. In an image, 
contours define boundaries of identified structures, or regions, that have the same gray 
levels.  Contour rendering uses defined boundaries for each feature in the 2D data set. The 
user must define these 2D boundaries, so that the rendering system can use the boundary 
points to create the 3D object.  The simplest type of geometric rendering draws lines 
between the boundary points within each section, then displays a 3D object that is 
composed of these lines.  

Because the lines lie entirely within the 2D sections, the 3D object does not have a 
surface.  This is known as contour rendering because it creates geometric models 
composed of lines representing the outer boundaries of features (Figure 5). Contour 
renderings can be created quickly and they are useful for editing stacks prior to more 
complex rendering.  For example, we might use the contours to show where feature 
boundaries need editing. 

Figure 5: Contour rendering of cerebral microvasculature, made by automatically 
detecting the vessels in 42 sequential (1 µm) sections of rat cortex.  

 

Notice that the vessel boundaries are made up of lines lying within the plane of each 
section. These planes are not joined in the Z (depth) dimension, so the effect is as if we are 
viewing a stack of thin sections through the vessels.  The vertical (Z) separation of each 
section from its neighbors corresponds to the sectioning interval. 

Surface Rendering 

We can create a more realistic view of our 3D object by adding a surface.  This procedure 
is known as “surface rendering”. In M3D, the rendered surface is made up from the 
surfaces of boundary voxels. Applying shading and smoothing to the voxel surface creates 
quite realistic renderings. 
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Figure 6: A surface rendering of the cerebral microvasculature of the rat cortex. 

 

The simplest option is to put a surface onto selected voxels by density thresholding.  You 
can apply surface rendering to the structures created as 2D contours or you can just create 
a structure by density thresholding the 3D density data, then perform a surface rendering 
on the created “structure”. Dynamic density surface rendering is much less time-
consuming, but of course, the features of interest must be differentiated from background.  

In contour and surface rendering, feature boundaries need to be explicitly defined.  The 
power of a 3D rendering system comes from the ease with which boundary definition is 
performed and automatic boundary definition can reduce your work by an order of 
magnitude. M3D has flexible segmentation functions that should make minimal work of 
boundary definition.  The major ways to define boundaries for contour rendering are: 

1. Tracing each boundary manually. 

2. Using an “Autoscan” tool to point to a feature and automatically define its 
boundary. 

3. Using the “Scan area” function to define multiple boundaries automatically within 
a section. 

Use of the Autoscan tools or the Scan Area function allows rapid, convenient 
segmentation if the feature boundaries are distinct from background.  If features are not 
distinct, then boundaries must be defined by manual tracing. We cover automated and 
manual boundary definition techniques in later sections. 

Density Rendering 

If a 3D dataset contains density information, we can create volume renderings that display 
the density dimension. M3D has rendering types for maximum, minimum, surface density 
and density with color and variable opacity. This is done by calculating the accumulated 
voxel density values along the voxel array.  The accumulated voxel values are then 
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projected onto a 2D surface.  Accumulated values for maximum and minimum renderings 
will be the max. or min. voxel densities. For surface density renderings, the value will be 
that of the first voxel in the density range. 

Volume rendering often requires that some densities be shown with high visibility, while 
other densities are shown as semi-transparent, cloudy shapes. Visibility is manipulated by 
making some voxels transparent, depending on their density.  In showing the 3D view, we 
may assign high levels of transparency to areas that contain low summed voxel values, and 
high levels of visibility to areas with high summed voxel values.  This creates the familiar 
appearance of volume-rendered MRI images, where features appear as solid objects 
surrounded by a cloudy area. 

Voxel-based renderings with transparency have the advantage that they represent shapes 
and densities.  However, this type of rendering requires very powerful computers, and 
does not generally produce the most visually appealing views because our objects are not 
solid, and lack sophisticated lighting and texturing. 

 

Figure 7: A series of magnetic resonance images sections through a human head 
displayed as cutting planes within a density rendering. 

 

We can display voxels from the matrix in various ways.  For example, the cerebrum might 
be represented by voxels containing density values from 100-200 gray levels, while 
background contains voxels having values from 0-99 and 201-255 gray levels.  We can 
use the density values to segment the image.  In a procedure very similar to 2D 
thresholding, we set density criteria, and only voxels containing these densities are shown. 
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The simplest option is to put a surface onto the selected voxels. For example, the system 
could be told to show voxels between 100 and 200 gray levels as a surfaced object.  This 
creates an object whose surface is defined by voxels, instead of pixels.  However, the 
appearance of the volume rendering is not particularly different from a surface rendering 
of the same object.  

The brightness of the object surface is not calculated from its original density, but from its 
spatial relationship with the light source.  You might well question the need to perform 
volume renderings if the results are a surfaced model, but a single thresholding procedure 
segments the object from the 3D data set.  This is much less time consuming than 
segmenting features in each of the slices. 

Surface/Density Rendering 

Density renderings on their own do not have enough visual cues to allow perception of 
three dimensions. You can create a 3D dataset combining density and surface renderings 
that shows density data with reference to structure. 

Figure 8: A Surface/Density rendering of a series of MRI images through a human head 
showing a density rendering of the cerebral ventricles.  

 

Summary 

You will have to choose which method of rendering is most suitable for a specific dataset.  
If you want to extract simple anatomical structures from a series of sections, then a 
surfaced volume rendering will often yield the best results. If you want to show the density 
dimension, volume rendering with transparency is required.  M3D offers each of these 
techniques, and the following chapters contain detailed instructions for the creation and 
optimal display of 3D renderings.   
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The M3D Tutorial 

The M3D tutorial is designed to lead you into 3D reconstruction in a structured way.  As 
you move through the lessons, you encounter operations of increasing complexity.  We 
realize that you are probably keen to get started using your own samples right away, but 
try to resist the temptation to dive into Part 6 now.  You will soon become fluent with 
M3D if you learn the basics first. 

The tutorial is divided into seven parts: 

Part 1 - Starting M3D, loading images, simple rendering of a small stack. 

Part 2 - Defining structures in sections; contour rendering. 

Part 3 - Working with large image stacks. 

Part 4 - The 3D Rendering Control window. 

Part 5 - Presentation; changing the appearance of the rendered image. 

Part 6 - Cine loops; creating dynamic displays of the dataset. 

Part 7 - Making 3D measurements. 

This seems like a great deal of work, but you should be able to move through each tutorial 
session quite quickly.  We recommend you work through the tutorial at least twice; first 
using the sample images provided, and the second time using your own data. 

The 3D Sample Images 
The MCID Elite installation CD-ROM contains a set of sample images to accompany the 
tutorials. 

TO INSTALL THE 3D SAMPLE IMAGES: 

1. Select  Start > Settings > Control Panel > Add/Remove Programs. 

2. Select MCID Elite 6.0 from the list of programs, then press the 
[Change/Remove] button. This launches the MCID Elite Setup Wizard (Figure 9) 

3. Select Add/Remove Components, then press [Next]. 

4. Select M3D Tutorial Data from the list of program components (Figure 10). 
Note: DO NOT un-check any other checked components or they will be 

removed! 
5. Insert the MCID Elite CD-ROM in your drive, then press [Next] to complete the 

installation. 

6. The images are installed in the \MCID Elite 6.0\Defgeo folder. 
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Figure 9: To install the M3D sample images, select the ‘Add/Remove Components’ 
option… 

 

Figure 10: …then select the ‘M3D Tutorial Data’ option. Do not un-check any other 
listed components. 

 

The sample images consist of a series of 120 sections through a sphere and a hollow 
cylinder at 1µm intervals. Sections through the sphere are a series of disks of different 
diameters, and the sections through the cylinder look like a series of equal sized rings.  In 
sections 40 to 79 there is a square inside each disk (Figure 11). Reconstructions of these 
sections show a sphere and a hollow cylinder (Figure 12). Using different M3D rendering 
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methods and cutting planes reveals a cube inside the sphere or a square at a cut face 
(Figure 13).  These operations are all covered in this tutorial, and in the Advanced Details 
section of the manual. 

The gray level values of these structures are: sphere 100, square 200, ring 250. 

 

Figure 11: Some of the images in the 3D sample dataset showing sections of the sphere 
(circles) and the ring.  In images 41-79 there is a square inside the circle. 

 

Figure 12: Partial and full reconstructions of the 3D sample dataset.  

 

Figure 13: Cutplane applied to a structure rendering (A)  and a density rendering (B). 
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Tutorial Part 1: Starting M3D 

Your M3D software is supplied as part of a complete, new MCID Elite software package. 
After installing this package you can use the M3D option.  Open the Study menu and 
choose Select.  The Select Study dialog box appears, choose M3D. 

Figure 14: To start M3D, select the ‘M3D’ option from the Select Study dialog box. 

 

The new version of MCID works just like the previous one did and the M3D functions do 
not create any additional complexity in the other MCID operations. 

M3D Modes 
M3D has two modes, Construction mode and Rendering mode. The Stack window is 
the M3D Construction mode and the 3D Rendering Control window is the M3D 
Rendering mode. Construction mode is the default and allows you to load, edit, align or 
process 2D images and create a 3D dataset.  Rendering mode is used to display 3D 
datasets, create cine loops and make 3D measurements. 

You can switch between these display modes by clicking on the Rendering mode / 
Construction mode icon at the top right of the screen. 

 

          

 

A summary of the functions that can be performed in each mode is presented in Table 1, 
below.  
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Table 1: A summary of the differences between Construction Mode and Rendering Mode. 

M3D Icons 
When you select M3D as a study type, new icons appear on the icon bar.  

In Construction mode you see: 

 The Stack icon. This opens the Stack operational window. 

 The Rendering mode icon. This icon switches you from Construction mode 
into Rendering mode.  

In Rendering mode you see these icons: 

  The Construction mode icon. When you are in 3D Rendering mode, this icon 
switches you back to the Stack window (Construction mode). 

 The 3D Rendering Control window icon. This icon opens and closes the 3D 
Rendering Control window. 

Loading an Image Set and Creating a Stack 
The file handling commands in M3D are similar to those in MCID Elite, but instead of 
using individual images you are working with image sets most of the time. 

First you must select the number of channels needed to contain the image stack. Click on 
the Settings menu and select a Display format that provides 16 channels per page. 

Features Construction Mode Rendering Mode 

Purpose Preparing datasets for 
rendering 

Rendering prepared 
datasets 

Digitize  Yes Yes 

Stack editing Yes No 

Contour rendering Yes No 

Surface rendering No Yes 

Density rendering No Yes 

Surface and density 
rendering 

No Yes 

Measurements 2D 2D & 3D 
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Figure 15: The Stack window now contains a list of 16 channels.  

 

Click on the [Images] button at the bottom center of the window.  The Select Associated 
Images dialog box appears (Figure 16). 

The M3D sample image files are saved in a folder named DEFGEO.  You need to open 
DEFGEO and find the images 3DSAM001.IM to 3DSAM120.IM.  This is a series of 
120 sections from a computer generated image of a sphere and a hollow cylinder. For this 
part of the tutorial, you will load the first 16 sections into the 16 available channels. 

Figure 16: The Select Associated Image Files dialog box. 
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To load the images, click on the [Add] button.  This will display the Select Files dialog 
box, Figure 17. 

Figure 17: The Select Files Dialog box. 

 

Navigate to the \MCID Elite 6.0\DEFGEO folder.  Ctrl-click on the first 16 files in the 
list (3DSAM001.IM – 3DSAM016.IM), then click on [Add] to transfer the selections to 
the Select Associated Images dialog box. Click [Done] to return to the Select Associated 
Image Files dialog box (Figure 18).  Click the [Sort] button to make sure the files are 
arranged in their proper order.  When you click on [OK], the first image loads into 
channel 1, the second into channel 2 etc. and the last image in channel 16.  When loading 
is complete you have a stack of 16 sections loaded into 16 channels.  

Figure 18: The retrieved files have been sorted and are ready for loading. 
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If there is a checkmark in the Load first image calibration checkbox, calibration data 
(including a Z axis calibration) are loaded with the images and displayed in the Stack 
window Section Information list (Figure 19).  

Figure 19: The Section Information list in the Stack window, showing the first 15 of 16 
images. Scroll down to see the image 16. 

 

Images displayed on the image monitor have a star in front of the file name.  If this list is 
loaded into a system with the Display format set at 16 channels per page, all the sections 
are displayed on the image monitor.  With the Display format set to 4 channels per page, 
the first four images are displayed on the first page, the next four on the second page, etc.  

Making Measurements  
You can use any standard MCID Elite functions to sample the images in the stack.  For 
example, you can read fluorescence intensity and area from any section.  If the images are 
not pre-aligned, you can use the alignment routines to correct this.  Of course, these 
images are pre-aligned, so we will leave a discussion of section alignment until later.  You 
may want to experiment by making measurements and adjusting the image visuals, just to 
confirm that in Construction mode, M3D operates very much like MCID Elite.  

Creating a 3D Dataset 
A 3D dataset is prepared by interpolating voxels from a stack of 2D sections.  Making the 
3D dataset may take some time, because M3D must interpolate voxels from the entire 
stack of images, but once you have created a 3D dataset you can save it and then retrieve it 
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like any image file.  This allows you to retrieve and render 3D datasets without going 
through the process of loading stacks and interpolating each time. 

TO CREATE A 3D DATASET: 

1. Click on the 3D Modeling option in the menu bar. 

2. From the 3D Modeling menu, select Create 3D dataset.  The Create 3D Dataset 
dialog box appears. 

3. Click on [OK] to start the interpolation process. 

Figure 20: The Create 3D Dataset dialog box. 

 

M3D interpolates the stack to create a dataset. While the computer is performing the 
interpolation, an information box appears on the screen showing the percentage of data 
interpolated.  The current stack is quite small, so the process will be very fast. When it has 
finished, another information box appears prompting you to switch to Rendering mode.  
Click on [Yes]. 

 

If you answer [Yes], M3D switches you into Rendering Mode.  If for some reason you 
clicked No, you are still in Construction Mode. You can switch to Rendering Mode by 
clicking on the mode icon at the top right of the host display. 

 
When M3D switches to Rendering Mode, the 16 images on the display monitor disappear 
and you see a blank screen.  The 3D Rendering Control window opens on the program 
monitor. 
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The 3D Rendering Control window converts the interpolated stack into a 3D rendering.  It 
allows you to select the type of rendering you want to apply, the gray level ranges to 
include, the orientation of the rendering and which structures to render. 

For example, you can change the angle of illumination of the 3D image, apply different 
colors, change a structure’s transparency or apply a cutting plane to show internal details. 

Rendering the Sample Dataset 
Figure 21: The 3D Rendering Control window. The transform indicator is thin because 
you used only 16 sections to create the dataset. 

 
 

 

Setting the Rendering Range 

With the default gray level range set between 102-153, you would not see a rendering of 
your dataset because the gray levels of the circle and the ring fall outside these values. 
You need to adjust the range to include the gray level values of the circle and the ring.   

First, adjust the Range bar to change the voxel gray levels forming the image.  Double 
click on Range above the bar.  This brings up the Set Rendering Range (Levels) dialog 
box (Figure 22). 

Figure 22: The Set Rendering Range (Levels) dialog box. 

 

RENDERED STRUCTURES TABLE

TRANSFORM 
INDICATOR 
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Enter 90 gray levels for the Start and 120 gray levels for the End, (Figure 23A).  Click 
[OK] to set the range and then press [Apply] to see a solid disk. Double click on Range 
above the bar and enter 200 gray levels for the Start and 255 gray levels for the End, 
(Figure 23B).  Click [OK] to set the range and then press [Apply]. This time you see the 
ring. To see both structures you need to expand the range from a point above 250 to a 
point below 100. 

The left and right ends of the Range slider are adjustable. When you move the mouse 
cursor onto the left end of the slider, the cursor becomes a double arrow. Hold down the 
left mouse button and drag the left end of the slider down the scale to a point below 100 
(Figure 23C).  Click on [Apply].  This time you see the disk and the ring. 

Figure 23: The Range bar with the slider set to a range of gray levels that displays the 
disk(A) and the ring (B).  Expanding the range (C) shows both structures. 

(A)         (B) 

     

 (C) 

 
Figure 24: Rendering of the first 16 sample images with a rendering range set between 90 
and 255.  

 



MCID Elite Application Guide  M3D  21 

01-MW-0203 Imaging Research Inc. 

Manipulating the Image 
At the right side of the dialog box, there is an outline block with a red star at its center. 
This block (called the Transform indicator) represents the orientations of the 3D dataset.  
The red star shows the position of the light source. Move the mouse cursor to the red star, 
hold down the left mouse button and use the mouse to drag the light source to a new 
location. Click on [Apply] to see the effect of changing the direction of illumination on 
the image. 

The Rotation Cube lets you change the orientations of the dataset. To use it, move the 
mouse cursor to either a cube face, edge or corner and hold down the left mouse button. 
Drag the cube to change its orientation and then release the left mouse button. Click on 
[Apply]. The rendered image is redrawn in the new orientation. To restore the default 
orientation, click on the default icon.  

 
At the moment, you are working with a solid surface rendering, as shown in the rendering 
type drop down menu (just under the title bar of the window). M3D can perform many 
different types of rendering. These are discussed later in the tutorial. 

Summary 
During this part of the tutorial, you learned how to start M3D, how to load sets of 2D 
images and how to create a 3D dataset. You learned how to switch between Construction 
mode and Rendering mode and how to perform a simple surface rendering of a density 
data set.  Later in the tutorial you will use the same sample images, but this time rendering 
the entire 120 section set. 
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Tutorial Part 2: Defining Structures, Contour Rendering 

For Part 2 of the tutorial you will be working with the same set of images you used in Part 
1. You need to move back to the Stack window.  Click on the Construction mode icon at 
the top right of the screen. 

 

Defining Structures 
Near the top right of the Stack window there are two icons, a check box and a labeling 
control (Figure 25).  These control several related operations.  They allow you to create a 
list of labels and display the current one, display the ranges of defined structures, display 
one or more structures within the image set and perform contour rendering using the 
structures. 

Figure 25: The Structures area of the Stack Window. 

 

Clicking on Structure: calls up the Structures list (Figure 26).  This lets you define labels 
for structures and select which structure is the current one.  Type in the name of the 
anatomical structure you want to define, then  press [Add] to add it to the Structures list.  
If you want to keep the list of labels, open the File menu at the top left of the list and save 
it using File > Save. To load a previously saved label file, use the File > Open command.  
Files are saved with the .LBL file extension.  The Edit command lets you rename structure 
labels in the list, or delete them.  

Enter the labels “Ring” and “Circle” as described above and delete the “Untitled” label. 

Figure 26: The Structures list with the 3D 3dsamp.lbl label file. We called the structures 
circle and ring, because that’s what you see in the channels. You can use any names you 
like.  
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 This icon calls up the Defined Structures: Ranges window (Figure 31). 

 This icon calls up the Contour Rendering window (Figure 32). 

When you have created the labels, you can identify the structures in the images. Click on 
the Tools icon and the Structure toolbox appears. Select the Autoscan A tool. 

Figure 27: The Tools icon and Structure toolbox with Autoscan A tool selected. 

   

Select Circle from the Structures list, move the Autoscan tool to Channel 1 and click on a 
region of background.  Now move the tool into the circle and click again. The circle is 
outlined in red.  Move to the Channel 2, and repeat the process. Continue until you have 
defined the circle in all 16 sections. 

Figure 28: The Defined structures list in the stack window showing circle and ring 
defined. The Solid interior shows that the solid option was chosen in the Attributes dialog 
box. 

 

Select Ring from the Structures list, move the cursor back to the image display and define 
the ring. To change the color of the ring, click on [Attrib]. The Structure Attributes dialog 
box appears.  If there is a mark in the Display all defined structures checkbox, all the 
structures you define are displayed on the images. If the box is unchecked, M3D shows 
only the current highlighted structure. 
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Figure 29: The Structure Attributes dialog box. 

 

To choose a second color, click on the down arrow to the right of the Color: field. If there 
is a mark in the Solid Interior checkbox, you can use the Hidden icon in the contour 
window to “fill” the circles. If you make a mistake defining structures you can delete the 
error by clicking on the [Delete] button beneath the Defined Structures list (Figure 30).  
This calls up the Delete Defined Structures dialog box, that lets you delete the selected 
structure from the current section, all sections or all structures in all sections. 

Figure 30: The Delete Defined Structures dialog box. 

 

You can also remove structures individually by selecting the Delete tool in the toolbox. 

To see a table of the defined structures and the range of sections in which they occur, click 
on the Ranges icon to call up the Defined Structures: Ranges window. 

Figure 31: The Defined Structures: Ranges window showing the circle and ring defined 
on images in 16 channels.  

 

After you have defined one or more structures, you can proceed to interpolate and render 
them just as if you were using entire images. Very often, complex datasets are easier to 
understand if you use a “building blocks” approach and begin by working with a few 
structures from the images rather than attempting the entire set in one step. 
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Note: Each boundary detection function works within one section at a time, so you 
must define all the structure boundaries in one section before moving to the 
next one. 

Contour Rendering 
Contour rendering produces reconstructions of the defined structures and is often a useful 
first step to get an idea of how a rendering will appear. 

Click on the Contour Rendering icon.  The Defined Structures: Contour Rendering 
window appears. 

 
Figure 32: The Defined Structures: Contour Rendering window showing 16 sections of 
the circle and ring.  Selecting the Hidden icon creates the gray fill, and the Viewport icon 
calls up the Viewport in the lower left corner. 

 

The Contour Rendering window has a Rotation Cube and four icons on the right hand 
side. 

Contour Rendering Window Icons 

  Hidden 
The Hidden icon controls contour display. Contours are shown as a series of overlapping 
outlines (often called a “wire-frame” display). This is often very difficult to interpret, 
especially with more than 3 contours on the display. Clicking on Hidden adds a gray fill 
to each slice and obscures overlapping and confusing internal structures.  
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  Show rotation cube 

The Show rotation cube icon turns the rotation cube on and off. The rotation cube is used 
to control the orientation of the contour rendering (see below).  

  Default rotation 
The Default rotation icon resets the orientations (X, Y, Z) of the rotation cube and the 
contours to those of the original image data (see below).  

  Viewport 

The Viewport icon displays a “Viewport” in the lower left corner of the window. This 
contains a light-blue, adjustable frame. Move the mouse cursor onto the frame border. The 
cursor changes into a double-headed arrow. Hold down the left mouse button and drag the 
border to change the frame size. Releasing the mouse button redraws the image at a higher 
magnification. 

Move the mouse cursor inside the frame. The cursor changes into a white, 4 headed arrow. 
Hold down the left mouse button then drag the frame to a different area of the image. 
Releasing the mouse button redraws the image showing the new features. 

Rotation Cube 

The Rotation Cube lets you redraw the contoured image by changing the position of the 
X, Y and Z axes. To use it, point to either a cube face, edge or corner and hold down the 
left mouse button. Drag the cube to change the orientation and then release the left mouse 
button. The contoured image is redrawn in the new orientation. To restore the original 
orientation, click the Default rotation icon.  

Saving the Stack 
Defining several structures in a large stack of images takes time and can be rather tedious. 
You can save the stack by using the File > Save command in the Stack operational 
window.  Stack files are saved with a *.dg file extension.  These files save the screen 
contents and contain the following information: 

• Section list 

• Location of associated images (filenames and file types) 

• Density and spatial calibrations  

• Defined structures.  

When you want to load the saved stack file, use the File > Open command in the Stack 
window. 
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Creating a 3D Dataset from Defined Structures 
Creating a 3D dataset using structures is similar to the process you carried out in Part 1. 
This time, be sure to check the Structure data checkbox as well as the Density data 
checkbox, as shown in Figure 33. 

Figure 33: The Create 3D dataset dialog box with Structure data selected.  

 

TO CREATE A 3D DATASET:  

1. Open the 3D Modeling menu and select Create 3D dataset.   

2. In the Create 3D Dataset dialog box, place checkmarks in the Structure data and 
in the Density data checkboxes. 

3. Click on [OK] to start the interpolation process. 

This time, M3D interpolates the defined structures in the stack to create a dataset.  While 
the computer is performing the interpolation, an information box appears on the screen 
showing the percentage of data interpolated. When it has finished, another information 
box appears prompting you to switch to Rendering mode.  Click on [Yes]. 

Rendering the Dataset 
Choose the defined structures you wish to render by clicking on the appropriate checkbox 
in the Rendered structures table. Click on [Apply] to see the current rendering. 
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Figure 34: The 3D Rendering Control dialog box.  Checkmarks in the Render checkboxes 
show that the circle and ring defined structures are both part of the current solid surface 
rendering. 

 

Changing Colors 
If you want to show a defined structure in a particular color, click on the Color dot in the 
rendered structures table. The Set Color dialog box appears. Click on the down arrow to 
see a list of color choices. Click on [OK] to close the dialog box.  Click on [Apply] to see 
the change take effect. 

Figure 35: The Set Color dialog box. 

 

Summary 
In Part 2 of the tutorial you learned how to define two structures within a series of sections 
and interpolate the structures to create a contour rendering.  Then you used the defined 
structures to create a 3D rendering and applied some simple presentation changes to the 
rendering. 
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Tutorial Part 3: Working with Large Image Stacks 

For Part 3 of the tutorial you will be working with the same set of images you used in 
Parts 1 and 2. You need to move back to the Stack window.  Click on the Construction 
mode icon at the top right of the screen. 

 

Section Linking 
In the previous parts of this tutorial, you worked with 16 images from a set of 120 
sections. M3D had 16 available channels, so each image fitted neatly into one of those 
channels. Most 3D renderings, however, use far more than 16 sections.  For example, MRI 
images may contain over 100 sections, and each section must be used for the 3D rendering 
to appear realistic.  In this part of the tutorial, we introduce the idea of linking sections to 
image files. Unlike linking to physical channels, this is not restricted by the system 
configuration and lets M3D create stacks containing any number of sections.  

Linking to Image Files 
You should be familiar with the Settings > Display format menu that sets the display 
mode to show a single image on a page (single channel mode), or more than one image on 
a page (multi-channel mode).  Normally, each channel contains one image so the number 
of displayed images cannot exceed the number of available channels.   

Obviously, channel limitation is a serious problem.   For example, an image set might 
contain 100 sections, each measuring 512 x 512 pixels.  This would exceed even the 
channel capacity of MCID Elite, unless we compressed the images.  There must be a 
method for handling any number of sections at any resolution. M3D uses ‘image file 
linking’ as a solution to the problem.   

A channel is an M3D location for an image.  Some of the channels use image memory and 
are displayed.  As you move up or down in the image list selecting a new series of sections 
for display, M3D loads the associated image files.  Image files do not use memory 
resources until they are displayed, so any number of sections can be incorporated into a 
stack. 

For example, you might load 100 images into an M3D.  The first four are loaded into 
channels 1-4, and these are visible on the image monitor. You can see the images in 
channels 1-4, because they are in image memory.  The next four images are associated 
with image files 5-8, and are not displayed until you select them for display.  These images 
are held in host memory, or on disk, until you choose to view them.  At this point M3D 
automatically retrieves the files, and displays sections 5-8 with their associated images. 

If you are working with images linked to channels, all MCID Elite image processing 
functions work within the channel.  If you are working with images linked to files you 
must either overwrite the original image, or save the processed images in new files.  This 
is because the file linkage mode works with temporary copies of the images that are 
replaced when the next images are loaded. 
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Loading Linked Image Files 
1. Open the Settings menu and select Display format. 

2. Select the 16 channels/ page display mode to display sixteen images on the 
monitor. 

3. Click [OK] to exit the dialog box..  

4. Click on the [Change] button in the Section Information area of the Stack 
window. The Change Section Linkage dialog box appears.  

Figure 36: The Change Section Linkage dialog box. 

 

5. Select the Link to Image Files radio button. 

6. Click [OK] to exit the dialog box. 

7. Click on [Images] button in the Stack window. The Select Associated Image Files 
dialog box appears.   

Figure 37: The Select Associated Image Files dialog box.  

 

8. Click on [Add] to display the Select Files dialog box.  
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Figure 38: The Select files dialog box with all the files highlighted, ready for retrieval. 

 

9. Navigate to the \MCID Elite 6.0\DEFGEO folder and highlight all 120 files (click 
on the first file, then Shift-click on the last file). 

10. Click [Add] to transfer the list to the Select Associated Images dialog box. 

11. Click [Done] to exit the Select Files dialog box. 

Figure 39: The Select Associated Image Files dialog box now contains 120 images ready 
for loading. 

 

12. Click [Sort] to make sure the images begin with 3dsam001.im through to 
3dsam120.im. 

13. Click [OK]. The image filenames are displayed in the Section Information list, 
and the first 16 sections (Sc1-Sc16) are displayed on the image monitor. 
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Controlling the Image Display 

When you click on [OK], the first set of 16 images/sections are loaded into Channels 1-
16.  in the stack loads into Channel 1, the second in Channel 2, etc.  The last image is 
linked to image file 120.  Only the first sixteen channels are displayed on the monitor.  To 
move to sections 17-32, just highlight section 17 in the Section information list. 

Images displayed on the image monitor have a star in front of the file name.  If this list is 
loaded into a system with the Display format set at 16 channels per page, all the sections 
are displayed on the image monitor.  With the Display format set to 4 channels per page, 
the first four images are displayed on the first page, the next four on the second page, etc.  

Defining Structures 
You can define the circle, ring and box as separate structures in the entire stack, then 
create the dataset for a combined surface and density rendering. 

1. Click on the Tools icon to display thee Structure toolbox. Select the Autoscan A 
tool. 

2. Select Circle from the Structures list, move the Autoscan tool to Channel 1 and 
click on a region of background. Now move the tool into the circle and click 
again. The circle is outlined in red.  Move to the Channel 2, and repeat the 
process. Continue until you have defined the circle in each of the 120 sections. 

3. Select Ring from the structures list, move the cursor back to the image display 
and define the ring. 

4. Add Box to the structures list, move the cursor back to the image display and 
define the box within the circle. 

 
Note: Each boundary detection function works within one section at a time, so you 

must define the circle and ring structures in all sections. Defining several 
structures in a stack of 120 images takes time and can be rather tedious.  If you 
wish to stop the structure definition process and return to it later, save the 
stack by using the File > Save command in the Stack operational window.  
Stack files are saved with a *.dg file extension.  

Creating a 3D Dataset 
You can now interpolate the full set of images and produce a 3D dataset in the same way 
as you did in parts 1& 2 of the tutorial.  This time place a mark in the density and structure 
checkboxes to create a combined density/structure rendering. 
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Figure 40: The Create 3D dataset dialog box for combined density and structure 
rendering.  

 

1. Open the 3D Modeling menu and select Create 3D dataset.   

2. In the Create 3D Dataset dialog box, place checkmarks in the Structures and 
Density checkboxes. 

3. Click on [OK] to start the interpolation process. 

This time, M3D interpolates the defined structures and density in the entire stack to create 
the dataset.  While the computer is performing the interpolation, an information box 
appears on the screen showing the percentage of data interpolated.  When it has finished, 
another information box appears prompting you to switch to Rendering mode.  Click on 
[Yes]. 

Rendering the Dataset 
In the 3D Rendering Control window, click on [Apply].  This time you see the sphere 
(circle) and the hollow cylinder (ring). 

Figure 41: Rendering of the complete sample dataset. 
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Saving the 3D Dataset 
Defining structures in a large stack then waiting for M3D to interpolate is rather tedious, 
and you do not want to do this every time you intend to make a rendering.  If you save the 
3D dataset, you can recall it at any time without repeating the time-consuming 
interpolation step.  You will need the sample 3D dataset in the remaining parts of the 
tutorial, so now is an ideal time to save it. 

TO SAVE THE DATASET: 

1. Open the 3D Dataset menu (Figure 42). 

2. From the 3D Dataset menu select Save. 3D datasets are saved with a *.3st file 
extension and the saved files contain the following information: 

• Interpolated 3D voxels (density data, structural data or both). 

• Spatial and density calibrations. 

• Settings from the 3D Rendering Control window (rendering settings, 
range, color and transform). 

Figure 42: The 3D Dataset menu. 

 

It is important to appreciate the relationship between stack files and 3D dataset files. The 
stack file is an intermediate step between the raw data, which is a series of 2D sections, 
and the 3D dataset. Saving the stack saves all the relevant information necessary to create 
many different kinds of renderings from a single image set.  Saving the 3D dataset lets you 
recall it anytime, avoiding the need for tedious and time consuming interpolation. 

If you save the stack and 3D dataset files after you have made them, you can save a great 
deal of time by avoiding the preparation stages. Table 2 shows a comparison of the 
properties of stack and dataset files. 
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Table 2: A comparison of stack files and dataset files. 

Features Stack file  3D dataset file 

Purpose Saving prepared stacks Saving rendered datasets 

Extension *.dg *.3st 

Contents Section list, structures, 
calibrations, filenames 

Interpolated voxels, 
rendering settings, 

calibrations, filenames 

Summary 

In this part of the tutorial you loaded a large image set by linking each section to an image 
file.  As image files are not displayed until the images are loaded, there can be any number 
of them.  You then interpolated the stack of images to create a 3D dataset and saved it. 
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Tutorial Part 4: The 3D Rendering Control Window 

For Part 4 of the tutorial you need to be in Rendering mode.  If you are in Construction 
mode, click on the icon at the top right of the display. 

  

The 3D Rendering Control window controls dataset rendering and the appearance of the 
rendered image. You have used many of the features in the window already and should be 
familiar with the operation of the rotation cube, transform and range bar.  In Part 4 we 
describe other areas of the window. 

Figure 43: The 3D Rendering Control window.  

 

Density and Structures Data Table 

The Density/Structures table beneath the range bar is divided into 2 parts with density 
data shown in the upper part and structure data as defined in the structures list shown 
below.  These labels change to reflect the type of dataset you created from the stack, and 
the type of rendering you choose.  If you created a dataset using only density or structures, 
the table is not divided into upper and lower parts. 

In Figure 43, the density range shows Struct: r1.  This is abbreviated from Structure: 
Density Range 1. With more than one structure defined, Range 1 will be the first, Range 2 
the second, starting at lower end of the gray level scale.  If you choose a density rendering 
type, this label changes to Density 1, Density, 2 etc. 

The checkboxes enable other options.  If there is a check in the Render box, that data is 
used in the current rendering and the other checkboxes are active.  If the Cutpl box is 
checked, you can apply cutting planes to the rendering to reveal internal details. 
Transparency lets you adjust the transparency of the range to show internal structures.  

The number of checkboxes, and the legends that describe them, changes according to the 
rendering type selected. For example, the density rendering types show only a single 
checkbox, but the Structure: Surf types show four. 
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Revealing Internal Structures 

You can use cutplanes and/or transparency to reveal internal structures in the rendered 
image.  Before starting this part of the tutorial, open the Settings menu, choose the Display 
format option, and set the Display type to True Color. 

Figure 44: The Structures table showing 3 rendered structures, circle, ring and box, from 
the sample dataset. Cut plane applies to all the structures and transparency to none. 

 

Cutting Planes 

Before you begin, make sure you have checked the appropriate boxes in the rendered 
structures table. You cannot apply a cutting plane to a structure unless you select the 
appropriate Cut planes checkbox.  You can choose from a range of cutting plane 
functions by clicking on the Cutting Planes icon at the top right of the 3D Rendering 
control window. 

Click on the Cutting Planes icon. 

 

A horizontal icon bar appears.  Choose the Plane-cut icon. 

   

The transform changes to show the cutting planes applied to each axis and the cutting 
planes controls. 
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Figure 45: A cutting plane applied to the rendered sample dataset. The cut is made in the 
x-X axis and the result is shown in the next figure. 

 

Applying a Cutting Plane to a Rendering 

TO APPLY A CUTTING PLANE TO A RENDERING: 

1. Click on the down arrow next to the x-X field to see a list of axes options.   

2. Put the mouse cursor on one of the sliders, hold down the left mouse button and 
drag the slider along the scale.  As you do this, the transform shows the cutting 
plane position in blue and the red dots at the corners move along the axis of the 
cutting plane or planes.  

3. Click on [Apply] to see the effects. 

4. To reset the sliders to their original position you can either click on the [R] (reset) 
button or drag the sliders to the ends of the scale. 

Figure 46: A cutting plane (x-X axis) intersecting the sphere. The cut face shows a section 
through the sphere and the cube contained inside. 
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There are many more cutting planes options and you can experiment with all of them.  For 
more information see the Advanced Details section. 

Transparency 

Applying transparency to a density rendering reveals internal structures.  Transparency can 
apply to surface renderings or combined structure and density renderings.  Click on the 
checkbox for any rendered structure that you wish to make transparent.  The transparency 
checkboxes are “grayed” until you check the render box. 

Viewport 

The Viewport controls the magnification of the rendering.  When you place the cursor on 
any edge of the box the cursor becomes a double arrow.  Use this to drag the edge of the 
box then click on [Apply] to change the magnification. To view a different area, place the 
cursor inside the box, drag the box to a new location, then click on [Apply]. 
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Tutorial Part 5: Presentation 

For Part 5 of the tutorial you need to be in Rendering mode.  If you are in Construction 
mode, click on the icon at the top right of the display. 

  

In the 3D Rendering Control window, click on the window menu button to see the 
window menu (Figure 47).  This menu contains options for presenting the 3D renderings 
you create.  These display options are interactive and very subtle in effect, so you should 
be prepared to experiment with different combinations.   

Figure 47: The 3D Rendering Control window menu. 

 

Rendering Settings 
Presentation 

Click on Rendering settings and from the sub-menu choose Presentation.  The 
Presentation Settings dialog box appears, (Figure 48). 

Figure 48: The Presentation Settings dialog box.  
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Background Color 
This dialog box controls the background against which the 3D object is displayed.  The 
default background color is dark blue and this works well with light colored 3D objects, 
but some very effective images can be created using blue backgrounds and red objects. 
Other color combinations may or may not work for your samples, but that should not stop 
you experimenting.  

Dragging the red, green and blue sliders along the scale lets you “mix” new background 
colors. If you want to save the color as the default background, click on the [Set Dflt] 
button. 

When you have changed these settings, click on [Apply] in the 3D Rendering Control 
window to see the effects of your changes. 

Orientation Cue 
Visual cues are used to orient the object within 3D space.  The rotation cube corresponds 
to the cube in the 3D Rendering Control dialog box and shows the current orientation of 
the dataset. The data outline shows you the boundaries of the stack of images.  Clicking in 
each checkbox adds these cues to the rendered image display. 

When you have changed the orientation, click on [Apply] in the 3D Rendering Control 
window to see the effects. 

Surface Shading 

The rendered image is composed of a surfaced set of voxels.  The appearance of the 
surface must be adjusted carefully, to yield a realistic-looking image. Click on Rendering 
settings and from the sub-menu choose Surface Shading Settings.  The Surface Shading 
Settings dialog box appears. This dialog box gives you control over the surface 
appearance. 

Figure 49: The Surface Shading Settings dialog box showing the default settings. 

 

These controls are interactive in their effects and you should experiment with them to 
appreciate the results. 

Smoothing and Edge sensitivity tend to counteract each other if both are set high. A low 
smoothing and no edge sensitivity shows an image with jagged edges, while a high 
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smoothing on its own removes much of the surface detail. Mid range settings usually 
produce the most pleasing effects. 

Transparency and Reflection also tend to be counteractive.  Low settings of transparency 
obviously reveal very few internal structures.  Similarly, if both transparency and 
reflection are set high very little detail may be revealed. Increasing the transparency of a 
structure while keeping the reflection low reveals internal details. Increasing the reflection 
makes the transparent structure more visible, but may make an internal structure less 
visible, especially if the Glossy value is set high.  Mid to mid-high range settings usually 
produce the most pleasing effects. 

Glossy and Ambient apply a metallic sheen to the 3D images.  High settings of glossy 
create this effect while low settings of ambient dim the 3D image. 

After you change any of these settings, click on [Apply] in the 3D Rendering Control 
window to see the effects of your changes. Mid range settings usually produce the most 
pleasing effects. Click on [OK] to leave the Surface Shading Settings dialog box. 

Creating Ranges 

First, create 3 ranges for the 3 gray level values in the dataset. The procedure is: 

1. Move the cursor to an empty area in the Range bar. 

2. Hold down the left mouse button, then drag the pointer to a new position. 

3. Release the mouse button. 

Create ranges at about 100, 200 and 250 gray levels. Because the dataset contains just 3 
levels, the width of each range does not really matter, as long as they do not overlap.  If 
you make a mistake, you can delete the current range by pressing the [Delete] key.  

The left and right ends of the Range sliders are adjustable. When you move the mouse 
cursor onto one end of the slider, the cursor becomes a double arrow. If you hold down the 
left mouse button and drag the end of the slider you can increase or decrease the range of 
gray levels included in the sample dataset. Figure 50 gives an idea of suitable range 
settings for the sphere, square and ring. 

Figure 50: The Range bar with separate ranges defined for each gray level in the sample 
dataset.  

 

Rendering Types 
The number of options in the drop down menu varies, depending on the type of data 
interpolated in the stack. Table 3 shows a summary of the different rendering types. 



MCID Elite Application Guide  M3D  43 

01-MW-0203 Imaging Research Inc. 

Table 3: Rendering types available with density and structural data interpolations. 

Rendering Type Structure 
Data 

Density Data Density and 
Structure 

Data 
Solid Surface Yes Yes Yes 

Solid Surface/Cut Planes 
Density 

- Yes Yes 

Maximum Density - Yes Yes 

Minimum Density - Yes Yes 

Surface Density - Yes Yes 

Density Color Opacity - Yes Yes 

Structure:Surface/ Max. Density - - Yes 

Structure:Surface/ Min.Density - - Yes 

Structure:Surface/ Surface 
Density 

- - Yes 

Structure:Surf/ Density Color-
Opacity 

- - Yes 

 

The easiest way to understand the difference between each of the M3D rendering types is 
by comparing the effects of each one on the sample dataset. You should be able to 
compare the different rendering effects side by side, and for this you need to change the 
Display format. 

1. Open the Settings menu and select Display format. 

2. Under Display type, click on the True Color radio button then select 4 channels 
per page. 

3. Click on [OK]. 

4. Select the 3D Dataset menu and click on Open.  Load the dataset you saved at the 
end of Part 3. 

5. Click on [Apply].  The dataset appears in Channel 1.  

Now you can experiment with different rendering types in channels 2-4.  The procedure is 
very simple: 

1. Move the mouse cursor to the image monitor and place it in one of the empty 
channels. 

2. Move back to the 3D Rendering Control window and select a different rendering 
type from the drop-down list. 



MCID Elite Application Guide  M3D  44 

01-MW-0203 Imaging Research Inc. 

3. Click on [Apply].  The sample dataset is displayed in the channel.  Any cutting 
planes or orientations applied to the first rendering apply to all subsequent ones 
(provided you do not change them), so you should be able to compare the effects 
of different rendering types directly. 

Select each of the different rendering types in turn and apply it to the dataset. You need to 
create and adjust cutting planes to see some of the effects described in this section. 

Surface Rendering 

Solid Surface 
This displays renderings as surfaces of pre-defined structures or surfaces from selected 
ranges of densities.  You should see a sphere and a hollow cylinder. 

Solid Surface/Cut-Plane Density 
This displays the rendered surface and the density of the cutting planes. Select this 
rendering type and place a mark in the CP dens checkbox.  If you create a cutting plane in 
the X axis, you should see a hemisphere with a square at the center of the cut face (Figure 
46).  You may need to reset the transform to its default, and possibly adjust the X axis 
distance to see exactly the same image.  If you move the left cutting plane slider to a point 
between 18-20 on the scale, you should see something similar.  Keep this cutting plane 
while you experiment with the different rendering types.  It will help you understand what 
each rendering type reveals. 

Density Rendering 

Max Density 
Displays the maximum density in the entire 3D dataset.  Make sure that the range is set 
between 90 and 255 levels.  You should see a gray sphere and a white cylinder. The sphere 
contains a light-gray cube. Create a cutting plane that intersects the sphere in the X axis. 
You should see a gray hemisphere with a light gray square at the center of the cut face.  

Min. Density 
Displays the minimum density in the entire 3D dataset. You should see a gray sphere and a 
white cylinder. If you kept the cutting plane from the previous rendering, you should see a 
gray hemisphere.  

Surface Density 
Displays the density at the surface of the 3D dataset.  When you apply this rendering type 
to the sample dataset, the image appears similar to that shown by Minimum Density 
rendering. This is because the surfaces of the cylinder and sphere both have uniform 
densities. The “surface” revealed by the cutting plane shows the light-gray square at the 
center, because the cut face has 2 regions of different densities. 
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Density Color-Opacity 
This lets you adjust the opacity and intensity of the rendered surface to reveal internal 
details.  You need to adjust these settings to very low values (typically ~ 0.05) before you 
begin to see any effects.  Reducing the opacity of the sphere reveals the cube inside. Select 
0.04 for the Intensity and 0.013 for the Opacity.  Set the range between 90 and 250.  
With these settings you will be able to see the cube inside the sphere. 

Figure 51: The Range Indicator when Density Color-Opacity rendering selected. 

 

1. Point to the Gaussian curve and click the left mouse button.  Two markers 
appear, one at the peak and the other at the Full Width, Half Maximum Height 
point.   

2. Move the cursor onto the peak marker then click the left mouse button. The cursor 
changes into a white double arrow.   

3. Hold down the left mouse button and drag the double arrow downwards.  This 
reduces the Intensity value in the Status bar.  

4. Repeat steps 1-3 with the Square wave. 

5. Click on [Apply] to see the effects on the 3D dataset. 

Structure/Density Renderings 

These rendering types show the surfaces of defined structures and the density information 
inside.  When you choose one of these rendering types, different checkboxes appear in the 
Density/Structures table.  Before proceeding further with the tutorial we need to recreate 
3 ranges for the 3 gray level values in the dataset. 

PROCEDURE: 

1. Move the cursor to an empty area in the Range bar. 

2. Hold down the left mouse button, then drag the pointer to a new position. 

3. Release the mouse button. 

Create ranges at about 100, 200 and 250 gray levels. Because the dataset contains just 3 
levels, the width of each range does not really matter, as long as they do not overlap.  If 
you make a mistake, you can delete the current range by pressing the [Delete] key.  Select 
Structure: Surf/Max Dens. as the rendering type. 
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Figure 52: The Density/Structures table when one of the Structure/Surface renderings is 
selected. 

 

Density Data 
The Density: range #s in Figure 52 correspond to the three ranges set for the sphere 
(circle), cube (box) and cylinder (ring). If a Render checkbox is empty, density data from 
this range is not used in the rendering and the solid colored range slider changes to a 
chequered pattern.   

Structure Data 
If the Render checkbox is empty, the Surface, Transparency and Internal Density 
checkboxes are “grayed”.  If the Render checkbox is marked, some of the boxes become 
active.  There is a linkage between the availability of each checkbox as shown in Table 4. 

Table 4: The relationship between Structure checkboxes and their effects on the sample 
dataset. 

 

For this part of the tutorial, turn off the Ring structure by removing the checkmark from 
the Render checkbox.  Turn off the density r1, r2 and r3 densities as well.  When you 

Rendering Surface Transparency Internal 
Density 

Effects on 3D 
datasets 

No 
checkmark 

Disabled Disabled Disabled No rendering 

Checked Unchecked Unchecked Disabled No rendering 

Checked Checked Unchecked Disabled Structure Surface 
Rendering 

Checked Checked Checked Unchecked Structure Surface + 
Transparency 

Checked Checked Checked Checked Structure Surface, 
Trans + Int Density 

Checked Unchecked Disabled Checked Internal Density 



MCID Elite Application Guide  M3D  47 

01-MW-0203 Imaging Research Inc. 

have seen the effects of these rendering types on the sphere, apply them again to the sphere 
and the ring.  

Structure Rendering of the Sample Dataset 

Structure: Surf/Max Density 
Displays the surface of a defined structure and the maximum density inside if density data 
from this structure is used in the current rendering. If you apply this to the sample dataset, 
you should see the following: 

Sphere only -- A solid sphere. 

Sphere +Density: r1 -- A translucent sphere. 

Sphere +Density:r1+r2 -- A translucent sphere with a white cube at the center. 

Structure: Surf/Min. Density 
Displays the surface of a defined structure and the minimum density inside if density data 
from this structure is used in the current rendering. If you apply this to the sample dataset 
you should see the following: 

Sphere only -- A solid sphere. 

Sphere +Density:r1 -- A translucent sphere. 

Sphere +Density:r1+r2 -- A translucent sphere.  

You do not see the cube in this rendering because the minimum density value was 
rendered and that is 100 gray levels, the value created for the sphere. 

Structure: Surf/Surf Density 
Displays the surface densities of defined structures. If you apply this to the sample dataset 
you should see the following: 

Sphere only -- A solid sphere. 

Sphere +Density:r1 -- A translucent sphere. 

Sphere +Density:r1+r2 -- A translucent sphere.  

The results of this rendering look identical to the previous type.  This is because the 
surface density data for the sphere is uniform at 100 gray levels, the value used to create 
the sphere. 

Structure: Surf/Density CO 
This lets you adjust the opacity and intensity of each defined structure. If you apply this to 
the sample dataset you should see the following: 

Sphere only -- A solid sphere. 

Sphere +Density:r1 -- A bright translucent sphere. 

Sphere +Density:r1+r2 -- A bright translucent sphere.  
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The surface color of the sphere changes as you include density data.  The reason behind 
this change is the effect of overlaying one partially transparent surface color onto density 
data of a different color.  The end result is a color addition of both. 

Summary 

In this part of the tutorial you learned how to change the appearance of a 3D rendered 
image and experimented with the different types of density and structure renderings in 
M3D. 
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Tutorial Part 6: Cine loops 

For Part 6 of the tutorial you need to be in Rendering mode.  If you are in Construction 
mode, click on the icon at the top right of the display. 

  

A cine loop shows the 3D image as a dynamic display.  The moving display usually gives 
a much better appreciation of the relationships between 3D structures.  To make a cine 
loop, you create a number of  views of the rendering, each one from a different angle.  
When you play the cine loop you get the effect of movement of the 3D object or the light 
source, etc., depending on the type of loop you make. 

1. From the 3D Dataset menu select Open and load the dataset that you saved at the 
end of Part 3.   

2. Click on [Apply] to display the rendered image on the monitor. 

3. Open on the 3D Dataset menu and select Cine loop > Record. 

4. The Record Cine Loop dialog box appears (Figure 53). 

Figure 53: The Record Cine Loop dialog box. 

 

5. Click on the Partial radio button.  For now, just accept the defaults and create 10 
different views of the rendering at 10 degree intervals. 

6. Click on the Horizontal direction icon. 

 

7. Click on [Test] to see a “preview” of the cine loop. The transform in the 3D 
Rendering Control window rotates through the series of views that you specified.  
It is a good idea to use the test function to check the chosen settings before going 



MCID Elite Application Guide  M3D  50 

01-MW-0203 Imaging Research Inc. 

ahead with a full cine loop, as creating a large number of views of a 3D object 
takes time. The test function plays the cine loop once, then stops automatically. 

8. Click on [OK] to create the cine loop. 

As M3D creates the loop it shows each view on the image monitor, and an information 
box appears showing you, which step in the loop, M3D is creating. When it has finished, 
the Play Cine Loop dialog box appears (Figure 54).  M3D returns to the first view and 
begins to run the loop automatically. 

Figure 54: The Play Cine Loop dialog box. 

 

The Play Cine Loop dialog box contains the name of the cine loop, a description of the 
loop type and shows loop attributes. The Play Options area contains a slider control and 4 
buttons. The Interval slider changes the time interval between each view and 
consequently, affects the replay speed of the cine loop.  The interval is continuously 
adjustable between 30 msec and 2.93 sec. 

 This button starts the loop running in continuous play mode. The loop plays 
until you stop it. 

 Steps the loop forward 1 view at a time. 

 Steps the loop backward 1 view at a time. 

 Stops the loop. 

The [Load], [Save] and [Done] buttons are not active until you stop the cine loop.  If you 
click on [Done] before saving the cine loop, a prompt appears asking if you wish to 
proceed without saving it. Click on [Save] and save the cine loop to disk.  Cine loops are 
saved with a *.cnl file extension. Cine loops can also be saved as a collection of 
component TIFF files for export to other graphics programs.  To save a Cine loop as a set 
of TIFF files, select TIFF from the Save as type: drop down menu option. 
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Now you can create another loop using one of the other direction options.  Experiment 
with the Range control selecting full circles (Full), or partial circles (Partial) of rotation.  
If you use 10 views in a Full circle, the motion will be rather jerky (because each view will 
be taken at an interval of 36 degrees), but the loop runs very quickly.  Make a loop using 
20 views; image motion becomes smoother but it takes longer to create the loop. 

Different types of cine loop are described in more detail in the Advanced Details section 
of the manual. To experiment with other types of cine loop, select the Type: drop down 
menu from within the Record Cine Loop dialog box. 

Summary 

In Part 6 you learned how to record and play a cine loop of the rendered dataset. 
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Tutorial Part 7: Making 3D measurements 

You can make linear measurements on the rendered image using tools that are similar to 
those in the Standard study type, except of course they work in 3D. Clicking on the Tools 
icon while you are in Rendering mode opens the 3D Sample toolbox.  Any measurements 
you make are recorded in the data table. 

Note: The 3D Sample tools do not work with the density rendering types.  If you 
want to make measurements of the sample dataset, apply the Solid Surface 
rendering type first.  

3D Sampling Tools 

Figure 55: The 3D Sample toolbox. 

 

 
The 3D:Pointer. Move the mouse cursor onto the rendered image and click the left mouse 
button. The 3D Volume and 3D Surface data are added to the table. The default units are 
‘voxels’ for 3D Volume and ‘pixels’ for 3D Surface. 

 
The 3D:Volume tool.  This tool measures the 3D volume and 3D surface area of all 
structures of a designated color.  Move the mouse cursor onto the rendered image structure 
and click the left mouse button over the structures you wish to measure.    

 
The 3D:Line tool. This draws a line between two points and records the 3D distance. 
Move the mouse cursor onto the rendered image and hold down the left mouse button. 
Move the mouse and draw a straight line between two features of interest. Releasing the 
mouse button completes the measurement and the distance is recorded in the data table.  
The start and end points of the line must lie on the surface of the rendered object, or an 
error is recorded instead of a measurement. 

 
The 3D Length:Trace tool. This is similar to an Outline tool. Anchor one end of it to a 
feature and then trace along the surface drawing a border around the feature. Releasing the 
mouse button completes the measurement and the distance is recorded in the data table. 
All the trace points must lie on the surface of the rendered object, or an error is recorded 
instead of a measurement. 
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The 3D Length:Connect tool. This is similar to the Click-Outline tool. Click the left 
mouse button to define the starting point of the target outline and then move to the next 
feature and click again. Subsequent clicks of the mouse button joins together each point 
with a straight line. A final double click with the left mouse button records the data in the 
data table. All the connected points must lie on the surface of the rendered object, or an 
error is recorded instead of a measurement. 
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Tutorial Summary 

Now that you have completed the tutorial, you should have a good working knowledge of 
the M3D basics.  

You should be able to load images, define structures, and go from there into contour and 
surface rendering. You should know how to change the appearance of the 3D rendered 
image, how to make measurements from appropriate renderings and how to make a cine 
loop. If you are not sure about any of these procedures, work through the relevant tutorial 
section again. 

Part 1  - Starting M3D; loading images, simple rendering of a small stack. 

Part 2  - Defining structures in sections; contour rendering. 

Part 3  - Working with large stacks of images. 

Part 4  - The 3D Rendering Control window. 

Part 5  - Presentation; changing the appearance of the rendered image. 

Part 6  - Cine loops; creating dynamic displays of the dataset. 

Part 7 - Making 3D measurements from rendered images. 

We recommend you work through the tutorial again using your own samples this time, and 
exploring more of the features in M3D.   

There are many features of the program that just cannot be covered in an introductory 
tutorial. We encourage you to explore the program and read the Advanced Details section 
of this manual. 
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Advanced Details: Stack Window 

The Stack window is the M3D construction mode for loading and displaying images, 
defining anatomical structures within the images, and making contour renderings of 
defined structures.  It also has menus for aligning sections, normalizing backgrounds and 
interpolating the stack to create a 3D dataset.  You can also save stacks, datasets and lists 
of defined structures. 

Image Management 
The area on the left of the Stack window is used to manage the image stack. From here 
you can view image information, choose which images to display, add or delete individual 
images, change the Z-axis calibration or position, and/or change the way in which the 
images are linked (i.e., to channels or files). 

Figure 56: The image management area of the Stack window. 

 

Displaying Images 

The Section Information list lists all sections in the stack, the size of each image (Height 
x Width), the Z-axis position of each section, and the image filename associated with each 
section. The list is also used to select which images to display on the image monitor. 
Images currently displayed on the image monitor have an asterisk in front of the Section 
label. 

Images are displayed in sets that correspond to the Channels per page setting in the 
current display format (Settings > Display format). For example, if the display format is 
set to 16 channels per page, images are displayed in consecutive sets of 16 images. If you 
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click on Section 8, M3D will display Sections 1-16. If you click on Section 20, M3D will 
display Sections 17-32. 

Section Linkage 

Images may be linked to channels or to image files. Clicking on the [Change] button calls 
up the Change Section Linkage dialog box.  

Figure 57: The Change Section Linkage dialog box. 

 

If you select the Link to Channels option, every image in the stack is immediately loaded 
into a discrete channel. The maximum number of images you can load is consequently 
limited to number of channels physically present on the system. This is acceptable if you 
are working with small sets that contain only a few sections, but is a serious limitation 
when working with large image sets.  Most 3D reconstructions require large numbers of 
images. 

If you select the Link to Image Files option, images are linked to image files that do not 
use memory until they are needed by M3D. That is, the images are not loaded into 
channels until they are selected for display. You can load any number of images in this 
mode. 

Z-Axis Calibrations and Positions 

The X Y spatial calibration is defined in the Calibration window under the Establish > 
Distance menu option. The Z-axis position value is also initially defined in the Distance 
Calibration window by entering values for section thickness and section interval. When 
you create a new stack file, M3D uses the section interval data from the calibration 
settings as default values.  When you create a new volume from the stack, the depth of the 
interpolated cube is defined by the interval between the first and last slice, plus the section 
thickness.  

The [Z Pos] button allows you to establish a section interval if the images were not 
calibrated to begin with. You can also use this feature to change the interval between two 
individual images (e.g., if a serial section is missing), or to change the Z-axis position of 
the image in the stack. 

Pressing the [Z Pos] button calls up the Set Section Z Positions dialog box (Figure 58). 

TO ESTABLISH OR CHANGE THE SECTION INTERVAL: 

1. Select the Interval radio button. 

2. Check the Change all checkbox. 
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3. Enter the section interval in the entry field (i.e., the distance from the top of one 
section to the top of the next). 

4. Press [Set All]. 

TO CHANGE THE INTERVAL BETWEEN TWO INDIVIDUAL SECTIONS: 

1. Select the Interval radio button. 

2. Un-check the Change all checkbox. 

3. Select the upper section from the list. 

4. Enter the section interval in the entry field (i.e., the distance from the top of the 
selected section to the top of the next). 

5. Press [Set Selected]. 

TO CHANGE THE Z POSITION OF AN IMAGE: 

1. Select the Position radio button. 

2. Select the section from the list. 

3. Enter the new Z position (in spatial units relative to the position of the first section 
in the stack) in the entry field. 

4. Press [Set Selected]. 

Figure 58: The Set Section Z Positions dialog box. 

 

Deleting Images from the Stack 

The [Delete] button lets you remove images from the list in the left of the images window. 
Clicking on the [Delete] button calls up the Delete Sections dialog box. 
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Figure 59: The Delete Sections dialog box. 

 

Sections 
This radio button is active only when the section linking is set to Image files.  When you 
delete a section, the image and any defined structures are removed.  To delete one or more 
sections, highlight the relevant name(s) in the list then click on [OK]. 

Associated images only 
This radio button is active with both Image files and Channel linking.  When you delete 
the associated image, only the image itself is removed.  Any defined structures are kept, 
and you can load another image into the file if you wish.   

Adding Images to the Stack 

The [Add] button lets you add images to the stack.  You define the number of sections you 
want to add to the stack, and the section above or below which you want to insert them. 
For example, if you want to insert 3 sections below section 4 you enter this information 
then click on [OK].  The image list will “shuffle” down to create room for these additional 
image files. 

Figure 60: The Add Sections Dialog box. 
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Defining Structures in Images 
The right side of the Stack window contains a set of controls for defining structures (e.g., 
anatomical entities) in individual images (Figure 61). Contour and surface renderings may 
then be made from any defined structure. 

Figure 61: The Structures area of the Stack Window. 

 

Using these Structure Definition controls you can: 

• Create structure labels 

• Control the way in which structures are displayed 

• Delete defined structures 

• Create a contour rendering of defined structures 

Creating Structure Labels 

Clicking on Structure: calls up the Structures list. This lets you define labels for 
structures and select which structure is the current one. Type in the names of the 
anatomical structures you want to define. If you want to keep the list of labels, open the 
File menu in the dialog box and save it using File > Save. Label list files are saved with 
the *.lbl file extension. To load a previously saved label file, use the File > Open 
command. The Edit command lets you rename structure labels in the list, or delete them. 
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Figure 62: The Structures list. 

 

Defining Structures 

To define a structure in an image, first select the structure name from the Structures list 
(Figure 62). Then use any Structures tool to define the structure. Structure tools work 
just like Sample tools, except they don’t gather any data from the image (see Chapter 3: 
Gathering Data from Images in the online Reference Manual for complete instructions). 
Once a structure has been defined in at least one image, its name, color and display 
attributes appear in the Structures area of the Stack window. 

Figure 63: Structure tools are used to define structures in individual images. 

 

After you have defined one or more structures, you can proceed to interpolate and render 
them just as if you were using entire images. Very often, complex datasets are easier to 
understand if you use a “building blocks” approach and begin by working with a few 
structures from the images rather than attempting the entire set in one step. 

Displaying Defined Structures 

If there is a mark in the Display all defined structures checkbox, all the structures you 
define are displayed on the images. If it is unchecked, only the current structure is shown 
(i.e., the structure selected from the Structures area). 

Structures can appear on images as outlines or completely filled with color. To fill the 
outlines with color, check the Display filled outlines option. 

To change the color of a selected structure (outlined or filled), click on [Attrib].  The 
Structure Attributes dialog box appears. 
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Figure 64: The Structure Attributes dialog box. 

 

To change the color of the structure, click on the down arrow to the right of the Color: 
field.  

Solid interior 
If you place a mark in the Solid Interior checkbox, when you select the Hidden icon in 
the Contour Rendering window a gray “fill” is applied to the contours.  If the box is not 
checked, only surface voxels are created in the 3D dataset, and the 3D structure will be 
hollow. 

Inclusions 
M3D creates 3D surface renderings of anatomical structures from a 3D ‘dataset’.  The 
dataset is prepared by interpolating voxels from a stack of 2D sections.  The 3D 
dimensions of any given structure are consequently determined by i) the section interval, 
and ii) the outline of the anatomical structure (as defined by the user in the individual 
sections). 

While this method provides an accurate 3D visualization of relatively large structures, it 
may not be suitable for visualizing small, spherical or particulate matter (e.g., vesicles).  If 
the diameter of such structures is less than the section interval, for example, the structures 
will appear tube-shaped in the rendered image. 

M3D allows the user to designate these kinds of structures as ‘inclusions’.  When 
designated as such, M3D will not perform any interpolation.  Instead, M3D will model 
and display the rendered structures as discrete spherical-shaped objects.  The radius of 
each sphere is derived from the dimensions of its corresponding 2D outline (mean of its 
height + width) and each sphere is positioned in the Z-axis so that its center bisects the 
surface plane of the 2D section. 

To designate a defined structure as an inclusion, check the Inclusions box.  When 
checked, all objects defined under the given structure name will be rendered as individual 
spherical-shaped objects. 

Deleting Structures 

This lets you delete a structure from the list.  You can delete a selected structure from the 
current section only or from every section.  If you select All, you will be prompted to 
confirm that you want to delete all defined structures. 
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Figure 65: The Delete Defined Structures dialog box. 

 

Gathering Data from Structures 

Structure tools do not normally gather data. However, if you wish to gather data from 
structures as they are defined, press the [Sample] button. This opens a dialog box that lets 
you select measurements and gather data from structures in individual images. Data are 
subsequently reported in the data table of the Sample window. 

Figure 66: The Sample Defined Structures dialog box with some selected measures. 

 

Structures 
The All and Current radio buttons select sampling of all the defined structures and targets 
or only the current one. 

Target 
Targets refer to the outlines of a defined structure in a series of sections.  A defined 
structure can consist of more than one target. Data can be reported for either Groups or 
Individual targets. 

Group -- shows the mean of all the targets of each structure within each section. 

Individual -- reports data from each individual target. 

Clicking on [Select Meas] opens the Measures Selection dialog box. You can choose from 
several categories of measurements (see Chapter 4:  Selecting Measures in the online 



MCID Elite Application Guide  M3D  63 

01-MW-0203 Imaging Research Inc. 

Reference Manual). When you click [OK], the system processes the selected structures in 
each section and records the data in the data table.   

Note: In M3D, a “region” is another name for a structure. 

Automatic Structure Definition 

MCID Elite’s automatic target detection feature (Scan Area) may be used to automatically 
define structures in individual images. To use this feature, first click on the Scan Area 
icon: 

 

The Scan Area dialog box appears, which allows you to establish a set of “target criteria” 
(i.e., features that distinguish structures of interest from other image features).  Target 
criteria may be based on any combination of density, size, or shape. For complete 
instructions, see Chapter 8: Automated Target Detection in the online Reference Manual. 

Figure 67: The Scan Area dialog box is used to define target criteria and to access a 
variety of target detection options and features. 

 

Once you have established a set of target criteria for a given structure, press the [Scan] 
button.  A Scan <Structure Name> dialog box appears next, which allows you to specify a 
range of sections to scan. You can scan the entire stack or a subset of sections. The idea is 
to select a range of sections in which the structure of interest is actually present. When you 
exit the dialog box, M3D automatically searches the specified sections and outlines the 
structures that satisfy all of the target criteria. 
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Figure 68: The Scan dialog box is used to specify the range of sections in which the 
structure of interest is present. 

  

Other Controls 

Two additional icons are displayed in the Structures area of the Stack window. 

 Ranges 
Press the Ranges icon to display the Defined Structures: Ranges dialog box (Figure 69). 
This dialog box lists the range of sections/channels in which the structures have been 
defined.  If you see ** alongside an entry in the table, this indicates that the structure is not 
consecutively defined in the range. 

Figure 69: The Defined Structures: Ranges window showing structures in sections 1 to 
16. 

 

 Contour rendering 
Press the Contour rendering icon to display a contour rendering (“wire-frame” 
reconstructions) of selected structures. Contour rendering is described below. 

Saving Stacks and Structures 
Defining several structures in a large stack of images takes time and can be rather tedious. 
You can save the stack by using the File > Save command in the Stack window.  Stack 
files are saved with a *.dg file extension.  These files save the screen contents and contain 
the following information: 

• Section list 

• Location of associated images (filenames and file types) 

• Density and spatial calibrations  

• All defined structures.  
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When you want to load the saved stack file, use the File > Open command in the Stack 
window. 

Contour Rendering 
Contour rendering produces 3-dimensional “wire-frame” reconstructions of defined 
structures. To create contour renderings, press the Contour rendering icon: 

 
This displays the Defined Structures: Contour Rendering window (Figure 70). 

Figure 70: The Defined Structures: Contour Rendering window. 

 

The Contour Rendering window has a Rotation Cube and four icons on the right hand 
side. 

Contour Rendering Window Icons 

  Hidden 
The Hidden icon controls contour display. Contours are shown as a series of overlapping 
outlines (often called a “wire-frame” display). This is often very difficult to interpret, 
especially with more than 3 contours on the display. Clicking on Hidden adds a gray fill 
to each slice and obscures overlapping and confusing internal structures.  

  Show rotation cube 

The Show rotation cube icon turns the rotation cube on and off. The rotation cube is used 
to control the orientation of the contour rendering (see below).  
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  Default rotation 
The Default rotation icon resets the orientations (X, Y, Z) of the rotation cube and the 
contours to those of the original image data (see below).  

  Viewport 

The Viewport icon displays a “Viewport” in the lower left corner of the window. This 
contains a light-blue, adjustable frame. Move the mouse cursor onto the frame border. The 
cursor changes into a double-headed arrow. Hold down the left mouse button and drag the 
border to change the frame size. Releasing the mouse button redraws the image at a higher 
magnification. 

Move the mouse cursor inside the frame. The cursor changes into a white, 4-headed arrow. 
Hold down the left mouse button then drag the frame to a different area of the image. 
Releasing the mouse button redraws the image showing the new features. 

Rotation Cube 

The Rotation Cube lets you redraw the contoured image by changing the position of the 
X, Y and Z axes. To use it, point to either a cube face, edge or corner and hold down the 
left mouse button. Drag the cube to change the orientation and then release the left mouse 
button. The contoured image is redrawn in the new orientation. To restore the original 
orientation, click the Default rotation icon.  

3D Modeling Menu 
The 3D Modeling menu includes functions that you might want to use before 
interpolation, such as axes definition, alignment and background normalization.  

Figure 71: The 3D Modeling Menu. 

 

Each of these operations is described below. 

Axis Definitions 
Sequential images collected on a microscope, or by an MRI scanner follow the accepted 
Cartesian convention in describing orientation and axes (i.e., X, Y and Z).  The Axis 
Definition feature allows the user to identify axes of the stack by assigning anatomical 
labels to them.  

Select 3D Modeling > Axis definitions to display the Axis Definitions dialog box (Figure 72). 
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Figure 72: The Axis Definitions dialog box. Ch 16 on the Z face of the orientation cube 
shows that sections are stacked in descending order. 

 

Stacking Order 

You can arrange sections in ascending or descending order by clicking on either of the 
Stacking order fields. The default is to have the sections arranged in ascending order, as 
this is consistent with the orientation of subsequent renderings. 

Face Labels 

The cube faces are labeled X,Y and Z by default, but any appropriate labels can be entered 
using the Face Labels entry fields. You might want to define them as “Dorsal-Ventral”, 
“Left-Right” or “Anterior-Posterior”. Only one character is allowed for each face, 
however, so in the above example you could use “D-V”, “L-R” and “A-P” respectively. 

View 

The area shows a skeleton cube and the horizontal, vertical and orthogonal axes.  The 
cube faces show the axes labels. X, Y and Z are the default labels and the red letters 
indicate the faces that you can see in this particular orientation.  Faces you cannot see are 
labeled with pale blue letters. 

Set Dflt  

You can set any combination of axes labels as the default. 

Restore Dflt  

This button restores the default conditions, if you have made temporary adjustments. 

Normalizing Sections 
Images need to be normalized to account for differences in background densities and 
calibrations. This is especially true of microscope images taken from serial sections. The 
sectioning process may cause variations in thickness between sections, and the material 
may not be consistent in different regions within a single section. 
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To normalize a set of sections, select 3D Modeling > Normalize. You can normalize 
Background densities (in uncalibrated images) or Calibrated densities (in calibrated 
images). 

Normalizing Backgrounds 

If the stack images have no density calibrations, select 3D Modeling > Normalize > 
Backgrounds. The Normalize Backgrounds dialog box (Figure 73) and the Background 
toolbox (Figure 74) appear. 

Figure 73: The Normalize Backgrounds dialog box. The graph shows background pixel 
values as density levels  (0-255) on the Y axis plotted against section numbers on the X 
axis. 

 

Section Selection 
The default settings will normalize all the sections in the current stack, but you can use a 
smaller number of sections if you wish.  Type in the first and last sections you want to use 
in the entry fields at top left of the dialog box. 

Background Definition 
Background density/intensity can be defined in two ways. The Global average method 
calculates the background value as the average gray level value of the entire image or in a 
user-defined area. The Histogram peak method calculates the background value from the 
gray level at the histogram peak of the entire image or in a user-defined area. 

If you wish to base the normalization on a user-defined area, select a suitable Background 
tool then transfer the cursor to the image. Move the target tool to a region of typical 
background density and click the left mouse button. A target appears on the display and 
background values within this target are recorded.  Draw a target on each section in the 
stack. 
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Indicate whether you are working with Brightfield specimens (i.e., dark objects on a light 
background) or Darkfield specimens (i.e., bright objects on a dark background). This 
determines which algorithms M3D will use for normalization. 

Figure 74: The Background Target Selection toolbox. 

 

Normalized Image Saving Options 
You can overwrite the existing image files, or save the normalized data in new files. 

Overwrite Original Files -- The normalized images overwrite the original data. 

Write to New Files -- This option lets you define new filenames to save the normalized 
images. Press [Define] to specify the new filenames. 

Keep in Channels -- You may decide to work with the normalized images but not to save 
them. If this is the case, click on this radio button. 

Note: The Keep in Channels option is not available if you are working with images 
linked to channels. In this case, you must decide whether to overwrite the 
original files or store the normalized images as new ones.  Use File > Save (or 
Save As) to save the stack file after performing a normalization. 

Starting the Normalization Process 
Click on [Apply] to start the background normalization process. The graph at the top right 
of the dialog shows the background values for the selected sections.  When the 
normalizing process has finished, the graph updates to show the normalized background 
values. To close this dialog box, click on [Done]. 

Normalizing Calibrations 

Calibrations need to be normalized to account for variations in density values arising as a 
result of experimental procedures. For example, suppose you had a series of isotopically 
labeled brain sections exposed on different pieces of film. The calibration for any section 
will not apply to other sections because the exposure will not be the same for each piece of 
film.   

If the sections you are using are calibrated by relative calibration (e.g., as part of a 
consecutive series of images), a warning appears advising you that Normalize Calibrations 
is not available. 

Selecting 3D Modeling > Normalize > Calibrations calls up the Normalize Calibrations 
dialog box (Figure 75). 
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Figure 75: The Normalize Calibrations dialog box.  The images in channels 3 to 6 do not 
include calibration data.  These are assigned a calibration status from section 1 in the 
stack.  M3D normalizes calibrations for these sections using the assigned values. 

 

Section Selection 
You can define a range of sections to use in normalizing calibrations.  This might be all 
the sections in the stack, or only those which have calibration data.  Any section that does 
not have intrinsic calibration data can be assigned data from a neighboring section, as 
shown in Figure 74.  Calibration status shows which image calibration is assigned for the 
section. 

Calibrations 
Reference Calibration -- Clicking on the down arrow shows a list of sections that include 
calibration information.  Any of these sections may be used as the calibration reference.  
Images that do not have calibrations do not appear in the list. 

Default Assignment -- Sets the default condition for calibration assignment. If the Above 
radio button is selected, any section lacking calibrations uses the values from the section 
immediately above it in the list.  With Below selected, the next section in the list is 
assigned for calibrations. 

Sections/Images -- Shows the list of channels, the filename of the image in each channel 
and its calibration status. 

Calibration Status -- Shows whether a section has its own calibration or is assigned a 
calibration from another.  If the default calibration is not correct, double clicking on a 
section in the list calls up the Assign Calibration dialog box (Figure 76). 
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Figure 76: The Assign Calibrations dialog box.  This selection overrides the default 
assignment. 

 

The Destination section is the one that you double clicked on to open this dialog box.  
The Calibration source is the section currently assigned to it. Clicking on the down arrow 
shows a list of images that include calibrations. Select one you want to assign to the 
Destination section, then click [OK]. 

Normalized Image Saving Options 

You can overwrite the existing image files, or save the normalized data in new files. 

Overwrite Original Files -- The normalized images overwrite the original data. 

Write to New Files -- This option lets you define new filenames to save the normalized 
images. Press [Define] to specify the new filenames. 

Keep in Channels -- You may decide to work with the normalized images but not to save 
them. If this is the case, click on this radio button. 

Note: The Keep in Channels option is not available if you are working with images 
linked to channels. In this case, you must decide whether to overwrite the 
original files or store the normalized images as new ones.  Use File > Save (or 
Save As) to save the stack file after performing a normalization. 

Aligning Sections 
Image sets created by tomographic scans or optical sectioning are inherently pre-aligned. 
The section alignment functions are used to compensate for shifts in the relative positions 
of anatomical structures that often occur during physical sectioning of tissues and organs.  
If sections are not pre-aligned, this procedure is essential for correct 3D model 
construction and rendering. 

Select 3D Modeling > Align sections.  The Selection toolbox and the Align Sections dialog box 
appear. 

Figure 77: The Selection toolbox.  
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The Selection toolbox contains 3 tools: 

 The Box tool is used for defining image texture areas on the reference section. 

 The Fiducial tool is used to place fiducial points on images. 

 The Delete tool is used to remove box targets and fiducial points. 
Note: The Box tool is active only when you choose Area: Selections as your section 

alignment criteria. 
Figure 78: The Align Sections dialog box showing selected structure and fiducial points.  
Notice that ‘Keep in channels’ is grayed because M3D is using 120 sections linked to 
image files.  

 

Section Selection 

The default settings will use all the sections in the current stack, but you can align a 
smaller number of sections if you wish.  Type in the first and last sections you want to use 
in the From: To: fields at top left of the dialog box. You may also change the reference 
section if you wish. 

Section Criteria 

You can use any combination of section criteria for alignment. You can use entire images, 
selected regions of images, a defined structure or a combination of these parameters. 

Selected Structure 
If you defined one or more distinct structures in the stack, you can use one for image 
alignment.  Click on the checkbox and the drop down menu becomes active.  Click on the 
down arrow to see the complete list of defined structures.  There is a constraint in using 
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defined structures for alignment.  You can have only one outline per section for the 
selected range. 

Image Texture 
Click in this checkbox to make the Area options active.  

If you select the Area: Entire Images radio button, the alignment uses entire sections.  

If you select the Area: Selections radio button then press the middle mouse button to 
move the Box tool to the image monitor.  Re-size the box if necessary and move it to the 
Reference section. When you click the left mouse button, a target box is drawn on the 
reference image. You can define targets on the reference section only, it is not possible to 
draw targets on the other sections. There is no limit to the number of targets you can 
define, but you should try to use similar features that are present in each section. When 
you click on [Apply], the alignment proceeds using the selected area on all sections. 

To remove the box target from the reference section, select the Delete tool place it inside 
the box then click the left mouse button. 

Fiducial Criteria 

Fiducial points are markers that can be accepted as a fixed basis for reference or 
comparison.  In a series of sequential images fiducials may be clearly defined anatomical 
structures, or they may be artificially inserted markers.  You can designate any point as a 
fiducial if it is present in all the sections you want to align, and at the same relative 
position in each one. 

Select the Fiducial tool from the Selection toolbox, then click the middle mouse button to 
transfer the cursor to the image display.  The Fiducial tool (a red cross-hair) appears on 
one of the images. Move it to a suitable fiducial point (e.g., an anatomical landmark that is 
visible in all images to be aligned) and click the left mouse button.  A red cross and the 
fiducial point number appear at the same XY coordinates on each of the displayed images. 
Move to the next point and click the left mouse button to define the second fiducial point.  
The most recently defined point is shown in the highlight color (green), previous ones in 
the current color (red).  Accurate alignment requires at least 2 fiducial points, but 3 or 
more is recommended. 

The idea is to now move the fiducial points in the other images so that they are aligned 
with the same anatomical landmarks as the reference image. To move a fiducial point, 
place the Fiducial tool over the numbered fiducial point.  The Fiducial tool changes into a 
hand with the index finger extended. The fiducial point marker and label change from red 
to green.  By moving the finger onto the fiducial point and pressing the left mouse button 
you can “nudge” the point to a new location. This lets you fine-tune the alignment of the 
fiducial points with the features of interest.  Minute adjustments are much easier at higher 
magnification. Press <Ctrl - Z> to zoom your image. 

To perform the alignment operation, press [Apply]. M3D rotates and/or shifts the images 
so that the anatomical landmarks are in the same XY coordinates as the reference image. 
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Fiducial points are saved with an image series if you save the image stack using File > 
Save command after closing the alignment dialog box.  When you re-open the file, 
however, the fiducial points are not visible until you select Align Sections from the 3D 
Modeling menu.  

To delete a fiducial point from a section, select the Delete tool, move the tool onto a point 
and click the left mouse button. 

Figure 79: The Modify Fiducial Range dialog box. 

 

Range 
The [Range] button lets you define or modify the range of selected fiducial points. Some 
of the fiducial points may not extend through the entire range of sections. For example, in 
a range of 40 images, fiducial number 3 may be present only in sections 1-23. In this case 
you would select it for this limited range, then create another fiducial for sections 23-40.  
Notice that you need an overlap between the two fiducial ranges. 

If the Full Range checkbox is marked, fiducials are defined on each section in the stack.  
For example, in our sample dataset we have 120 images, so this will be the full range.  If 
the Full Range checkbox is not selected, and you define a fiducial point, a dialog box 
appears prompting you to enter the range for this fiducial point.  

Insert 
The [Insert] button lets you insert an additional fiducial point into an existing series of 
points. For example, if you were using the delete tool and you deleted fiducial point 
number 1 from section number 10 by mistake.  Pressing [Insert] lets you correct the error 
by re-defining the missing fiducial point. 

Remove 
This lets you remove a fiducial point from all sections simultaneously. 

Aligned Image Saving Options 

You can overwrite the existing image files, or save the aligned images in new files. 

Overwrite Original Files -- The aligned images overwrite the original image files. 
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Write to New Files -- This option lets you define new filenames to save the aligned 
images. Press [Define] to specify the new filenames. 

Keep in Channels -- You may decide to work with the aligned images but not to save 
them. If this is the case, click on this radio button. 

Note: The Keep in Channels option is not available if you are working with images 
linked to channels. In this case, you must decide whether to overwrite the 
original files or store the aligned images as new ones.  Use File > Save (or 
Save As) to save the stack file after performing an alignment. 

When you want to leave this dialog box, click [Done]. 

Creating a 3D Dataset 
The 3D Modeling > Create 3D dataset option interpolates the images in the stack. When 
you click on [OK], the interpolation process begins and when it is complete you are 
prompted to move into the Rendering window. 

Figure 80: The Create 3D Dataset dialog box. 

 

Component Selection 

If you defined one or more structures when you were in the Stack window, the next two 
items are active, otherwise they are “grayed out.” Selecting the Density and/or Structures 
checkboxes controls the types of renderings available in the Rendering types list (Table 5). 

Density Data -- This option creates a 3D dataset containing density information. 

Structure Data -- This option creates a 3D dataset containing structural information (i.e., 
based on defined structures).  

If you base your rendering on Density data, you can choose between the full range of 
image data (e.g. 8, 10, 12 bit) or use a compressed range.  Compression reduces the 
bytes:voxel ratio from 2:1 to 1:1 and speeds up the rendering process at a cost of 
sacrificing density resolution. 
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Table 5: The full range of M3D rendering types. 

Section and Area Selection 

You may decide to use only part of the stack to create a 3D dataset.  Enter the first and last 
sections you wish to use in the From: To: entry fields. 

You may decide to use Entire images, or only some areas within sections to create the 3D 
dataset.  If you select the User defined radio button then press the middle mouse button, a 
box tool appears on the image monitor.  Move the box to one of the channels and re-size it 
if necessary.  When you click the left mouse button, the box is drawn on each of the 
displayed channels.  If you do not want all of the sections to contribute to the 3D dataset, 
select which ones to include in the From: To: fields.  When you click on [OK] the 
interpolation proceeds, but includes only the user defined regions of interest in the 
specified sections. 

The Compression option lets you choose from no image compression (None), up to 
8x8x8 image compression.  Rendering of large datasets is much faster with compressed 
images, and these do not use as much disk space or memory. Of course, increasing the 
rendering speed sacrifices some of the rendering quality. 

The Dataset Size section of the dialog box shows the volume size in voxels and the 
amount of memory needed to create the dataset.  If you selected User defined, the field 
displays an Invalid message until you define an area on the sections. 

Rendering Type Structure 
Data 

Density 
Data 

Density and 
Structure Data 

Solid Surface Yes Yes Yes 

Solid Surface/Cut Planes Density - Yes Yes 

Maximum Density - Yes Yes 

Minimum Density - Yes Yes 

Surface Density - Yes Yes 

Density Color Opacity - Yes Yes 

Structure:Surface/ Max Density - - Yes 

Structure:Surface/ Min.Density - - Yes 

Structure:Surface/ Surface Density - - Yes 

Structure:Surf/ Density Color-
Opacity 

- - Yes 
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Advanced Details: Rendering Control Window 

The 3D Rendering Control window controls the rendering of 3D datasets created from a 
stack of images.  When you interpolate a 3D dataset in the Stack window, the system 
prompts you to switch to rendering mode and into this window.  If you want to work with 
a previously saved 3D dataset, you can open the window by clicking on this icon. 

 

Note: Until you interpolate a stack to create a 3D dataset or open a saved dataset file, 
the Rendering types list, Range Bar and Density/Structures table are 
empty.  The Transform indicator is set to its default, and the [Apply] button 
is grayed out until you open or interpolate data. 

Figure 81: The Rendering Control window. 

 

The 3D Rendering Control window contains functions that affect the way in which an 
image is displayed.  The best way to appreciate these functions, and their subtle 
interactions, is to create a 3D rendering and then experiment with different rendered 
ranges, types of shading, angle of illumination, transparency, etc. Very small changes in 
these parameters can often have a very noticeable effect on an image. 

The Range Bar and Density/Structures List 
The Range bar shows the entire density range of the dataset and the chosen density range 
for any combination of defined structures and rendering type.  If the images are not 
calibrated, it displays the range as gray levels.  If a density calibration was established, it 
displays the range in Calibrated Units/Levels (or Levels/Calibrated Units). 
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Figure 82: The Range bar when the Solid Surface rendering type is applied. 

 

The Range bar allows you to render any image object that falls within the range of density 
values shown. To change the density range, simply drag the ends of the Range bar, then 
press [Apply] to create a rendering. To create multiple density ranges, place the cursor in 
an empty area of the Range bar and drag.  

Figure 83: The Status bar. 

 

The status bar has a green flash in the top left hand corner. Double clicking on the green 
flash or double clicking on any of the sliders in the range bar calls up a Set Rendering 
Range dialog box.  This is useful if you want to enter very precise values for the range 
settings and find the sliders difficult to adjust accurately. 

Figure 84: The Set Rendering Range dialog box with Calibrated range selected.  This 
shows the start and end of the rendering range in the calibrated units of the current 
dataset. 

 

Selecting other rendering types changes the appearance of the Range bar (see below). 

Maximum, Minimum and Surface Density Rendering 
Density renderings can display the Maximum, Minimum or Surface densities of the 3D 
dataset. 

Figure 85: The Range Indicator when Maximum, Minimum or Surface Density is selected. 
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The density range indicator is now split into two parts, a Range bar and a set of Visuals 
controls. The Range bar is used to specify the range of density values to be rendered (see 
section above). The Density Visuals controls (displayed above the Range bar) are used to 
modify the shades of gray (or colors) to which the density values are mapped. They work 
much like the LUT contrast controls in the Visuals operational window. To compress the 
LUT to a smaller range of density values, drag the ends of the control bar above the gray 
scale/color bar. To select another LUT (*.vis file), open the 3D Rendering Control 
window menu and select the Rendering settings > Density visuals option.  

Figure 86: Changing the gray scale/color map used for density renderings. 

 

Density Color and Opacity Rendering 
When you choose either of the color-opacity rendering types you see a graph of the 
distribution of density values displayed above the range of gray levels.  The default mode 
has a Gaussian curve applied to Density, and a Square wave applied to Opacity.  Other 
curve types are available for both parameters. 

Figure 87: The Range Indicator when Density Color-Opacity rendering selected. The 
display is similar with Structure: Surface Density-CO selected. 

 

Clicking on the Gaussian curve displays two markers, one at the peak and the other at the 
Full Width, Half Maximum Height point.  Move the cursor onto the peak marker and drag 
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it downwards.  This reduces the height of the curve and the Intensity value in the Status 
bar changes. Click on [Apply] to see the effects on the 3D dataset.  Other curves contain 
similar adjustable markers. 

Click on the Square wave to reveal the marker in the center of the horizontal part of this 
curve. Hold down the left mouse button and drag the double arrow downwards. This 
changes the Opacity value.  Click on [Apply] to see the effects on the 3d dataset.  

The graphic scale of Intensity/Opacity values is auto-sizing.  If you continue to drag the 
curve markers downwards, the scale and the curves are redrawn to new values. 

The Intensity and Opacity buttons in the status bar both have green corner tabs.  Clicking 
on one of these buttons calls up a dialog box that lets you enter Intensity/Opacity values 
to 3 decimal places. 

Figure 88: The Set Intensity dialog box. The Set Opacity dialog box is similar. 

  

Rendering Range and Mappings 

Double clicking on the Range bar calls up the Set Rendering Range dialog box.  This 
dialog will differ according to the current rendering type; with maximim, minimum or 
surface density renderings it shows the rendering range only. 

Figure 89: The Set Rendering Range and Mappings dialog box as it appears for color-
opacity renderings, showing the range displayed in gray levels and the intensity/opacity 
curves. 
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The dialog box shows the extent of the Rendering Range and includes a Calibrated range 
checkbox. Placing a mark in this box changes the scale to ROD units.  The dialog has 
fields for modifying Intensity and Opacity values.  Each field contains a numerical value 
box (Max:) and an icon showing the curve currently applied to this rendering range.  Click 
on either icon to see a fly-out bar with other possible curve types. 

 Applies a Square Wave to the rendered range. 

 Applies a Gaussian to the rendered range. 

 Applies a Left Gaussian to the rendered range. 

 Applies a Right Gaussian to the rendered range. 

 Applies a left Hyperbola to the rendered range. 

 Applies a right Hyperbola to the rendered range. 

The Transform Indicator 
Figure 90: The Transform Indicator. 

 

The red star at the center of the frame marks the position of the light source that is 
illuminating the 3D object. Move the mouse cursor onto the star and drag it to a new 
location. When you click on [Apply], the rendering is re-created showing the effect of the 
changed position of the light source. You can place the light source anywhere inside the 
Transform Indicator, it is not restricted to the Viewport. 

The light blue frame is the Viewport. Move the mouse cursor onto one of its edges or 
corners, the cursor becomes a double arrow. Hold down the left mouse button and drag the 
frame edge to change the frame size.  When you release the mouse button and click on 
[Apply], the rendering changes to shown the area inside the frame at a different 
magnification. 

If you move the mouse cursor into the frame, the cursor becomes a 4-headed arrow.  Hold 
down the left mouse button and drag the frame to a new position.  When you release the 
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mouse button and click on [Apply], the rendering changes to shown the new area inside 
the frame. 

Icons 

There are three icons located at the right hand side of the window. 

 Cutting Plane Modes 

This icon allows you to select different ‘cutting plane’ modes (i.e., different ways of 
sectioning a rendered object in order to view internal surfaces). The default mode is to 
apply no cutting planes to the rendering. 

 Default Transform 
This resets the Transform Indicator to its default. The orientation of the 3D rendering 
resets when you click on [Apply]. 

 Mirror Complement 

This produces the mirror image of the cut plane surfaces. The icon is active with the 
Plane-cut, Corner-cut and Corner-keep cutting plane modes (see below).   

Cutting Plane Modes 

Cutting planes are used to reveal internal structures in rendered images. Five cutting plane 
modes are available: 

 No-cut 

 Plane-cut 

 Corner-cut 

 Corner-keep 

 Slice 

Only one of these icons is visible at any time (default = No-cut). Click on it to see the 
others. 

 Selecting a cutting plane icon enables the cutting planes controls (Figure 91). There are 
three ways to define cutting planes: 

1. Move the mouse cursor to the slider, press the left mouse button and drag the 
slider along the scale.  
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2. Point and click on the left and right pointing arrows.  This increases or decreases 
the axes values one step at a time. 

3. Move the mouse cursor onto one of the red dots at the corners of the transform 
indicator. The cursor changes into a 4-headed arrow.  Press the left mouse button 
and drag the red dot along the axis.  If you have only one axis active, the other 
axes are marked by black dots. Click on one of the black dots, it changes into a 
red dot to show that this axis is now adjustable. 

You can adjust each axis independently, or all of them simultaneously.  When you are 
adjusting the axes, the transform indicator is immediately redrawn to reflect the changes.  
The scale above the sliders is also updated, indicating the position of the cutting plane.  
For example, if you selected only the X axis, the values for that axis are shown in red 
while the non-adjusted axes values are shown in black.  Reading from the left, the scale 
shows values for cutting planes in the X, Y and Z axes. 

To see the effects of cutting planes on the 3D image, click on [Apply]. 

To restore the axes to the default condition, click on the [Reset] button (labeled R). The 
transform indicator resets immediately, the image is re-drawn when you click on [Apply]. 

Plane-cut 
The Plane-cut icon lets you intersect the image using X, Y or Z cutting planes and display 
the cut surface to show internal structures. You can combine the cutting planes of all three 
axes, or use each one separately. 

Figure 91: The Cutting Planes controls with the Plane-cut icon selected and X axis 
adjusted. 

 

Corner-cut 
The Corner-cut icon lets you remove a corner from the 3D dataset.  The outer surfaces of 
the cut planes are displayed when the corner is removed. Clicking the Complement icon 
lets you display the inner surfaces of the removed part. 
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Figure 92: The Cutting Planes controls with the Corner-cut icon selected and X, Y and Z 
axes adjusted simultaneously. 

 

Each of the corners in the transform is marked with a small circle.  You can remove any 
corner by clicking on one of these circles. 

Corner-keep 
The Corner-keep icon lets you display a corner defined by X, Y and Z axes.  If you do not 
change the axes settings you used with the Corner-cut icon, the corner will be the one that 
was removed by that set of parameters.  In other words, Corner-cut and Corner-keep are 
complement to each other. 

Figure 93: The Cutting Planes controls with the Corner-keep icon selected and Z axis 
adjusted. 

 

There are small, hollow circular markers at each corner of the transform.  Clicking on one 
of these markers selects that corner as the origin of the cutting plane(s).  Click on Apply 
to see the effect of the cutting plane on the 3D dataset. 

Slice 
The Slice icon is included in the fly-out icon bar when you select the Surface Density 
rendering type.  It lets you create and display slices through the 3D image at one or more 
levels. One slice is the default, the maximum number of slices you can create is 15. 
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There are 5 different Slice cutting planes: Free, Perpendicular, X-axis, Y-axis and Z-
axis. These are identified by F, P, x-X, y-Y and z-Z and in the field at the left of the 
transform indicator.  To select these Slice cutting planes, click on the arrow next to the 
field then choose from the drop down list.  To select the number of slices, click on the 
arrow next to the number field.  To see the effects on the 3D dataset, click on [Apply]. 

Figure 94: Slice cutting planes. 

a. Free cutting plane 

 
A slice created in the X-axis is 
tilted by clicking on one head of 
the 4-headed arrow. The slice 
may have any orientation. 

b. Perpendicular cutting plane 

 
A slice crteated at the intersection 
of the X, Y and Z axes. The slider 
controls the distance along all 
axes simultaneously, always 
perpendicular to the viewing axis. 

c. X axis planes 

 
Two slices created perpendicular 
to the X-axis of the dataset. 
Moving the slider controls the 
positions of the slices. The +/- 
arrows control the distance 
between each slice. 

d. Y axis planes 

 
Two slices created perpendicular 
to the Y-axis of the dataset. 
Moving the slider controls the 
positions of the slices. The +/- 
arrows control the distance 
between each slice. 
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Mirroring Complement 

 
This option displays a mirror image of the cut face when either the Plane-cut, Corner-cut 
or Corner-keep cutting planes are applied. A good analogy for this procedure might be 
removing a segment when you prepare an orange.  When you remove a segment from the 
orange, you reveal the internal surfaces that separate the segment and its neighbors. The 
segment’s internal surfaces (which are now exposed) are the complement to the surfaces 
of neighboring segments. Some pre-conditions need to be met before you can apply the 
mirroring effect, and M3D prompts you to change parameters, if the current conditions are 
not appropriate for mirroring. 

Click on the Complement icon and the transform indicator is redrawn to show the mirror 
image of the intersections of any cutting planes. To see the mirror image on the 3D 
dataset, click on [Apply].  M3D draws the mirror image showing the internal faces of the 
removed segment.  The Complement icon acts as a toggle; to see the original rendering 
again, click on the icon, then click on [Apply].   

Default Transform 

 
You can edit the default values by clicking on the Default Transform icon while holding 
down the <Ctrl> key. This calls up the Default Transformation Settings dialog box. 

Figure 95: The Default Transformation Settings dialog box. 

 

Rotations 
Sets the default angles for the transform X and Y axes. 

Viewport 
This is a zoom function that increases or decreases the magnification of the rendered 
image. 
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Light Source 
The radio buttons select the default angle for the light source.   

Rotation Cube 
Double clicking on the Rotation Cube calls up the Set Rotation dialog box (Figure 96).  
Type in the X and Y default values for the rotation cube, then click on OK. 

Figure 96: The Set Rotation dialog box. 

 

The Window Menu 
The window menu opens when you click on the button at the top left hand corner of the 
3D Rendering Control window. 

Figure 97: The 3D Rendering Control window menu. 

 

Rendering Settings 

Clicking the Rendering settings menu option opens a sub-menu. 
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Figure 98: The Rendering Settings menu. 

 

Rendering Settings: Presentation 

The Presentation Settings dialog box controls how the 3D object is displayed against the 
background. The default background color is black and this works well with light 3D 
objects. You will have to experiment to find the best combination of colors for your 
samples. 

Figure 99: The Presentation Settings dialog box. 

 

Background Color 
Moving the sliders adjusts the amount of red, green and blue in the background color. If 
each of the sliders is set to the far left of the scale, the background color will be black. If 
they are set to the far right, the background color will be white. Moving the sliders lets you 
“mix” a new background color. In the 3D Rendering Control window, click on [Apply] to 
display the new background color. Click on [OK] to close the dialog box. 

If Blend is selected, it makes the background transparent and blends it into the rendered 
objects, but you will see the effects only if rendered structures are transparent.  If it is not 
selected, the background color applies only to the area surrounding the rendered object. 

Orientation Cue 
Show data outline shows the 3D dataset outline as well as the rendered image. The 
outline is displayed as a skeleton cube in your choice of color. 
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Show rotation cube displays the rotation cube with the rendered image. If you have 
rendered a complex image, (a large neuron for example) it is helpful to know the original 
orientation of the data. 

The [Set Dflt] button lets you save any combination of background colors and parameters 
as default settings. Press [Restore Dflt] to restore default conditions after adjusting the 
presentation settings. After changing any of these parameters, click on [OK] to leave the 
dialog box then click on [Apply] to see the changes take effect. 

Rendering Settings: Surface Shading 

The Surface Shading Settings dialog box (Figure 100) controls the appearance of the 
rendered surface. 

Figure 100: The Surface Shading Settings dialog box. 

 

Smoothing factor 
Smoothing is applied to the 3D data set.  This has the effect of minimizing the 
“voxellated” effect that makes the images look “blocky”. The degree of smoothing is 
variable from 1 to 4. 

Edge Sensitivity 
Edge sensitivity refers to the preservation of edge information during the smoothing 
process.  It should be set low if images are inherently smooth.  It can be set high if images 
contain a lot of detail that must be shown. The degree of edge sharpening is variable 
between 0 and 10. 

Transparency 
To display structures inside 3D renderings, the rendered surface needs to be transparent.  
Transparency is expressed as a percentage between 0 and 100%. The higher the 
percentage, the greater the degree of transparency and the easier it is to see internal 
features. To change the transparency, enter a new value then click on Apply to see the 
effect.  You may find it necessary to make several adjustments to the transparency before 
you are satisfied with the result. 
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Reflection 
This affects the brightness of a transparent structure and is variable between 0 and 100%. 

Glossy 
3D images often look best if the surface has a metallic sheen.  High settings of the glossy 
parameter create this effect. The setting is variable between 0 and 10. 

Ambient 
Brightens and dims the 3D image representing the effect of ambient light reflected from 
that part of the object that is parallel to the light source. The setting is variable between 0 
and 10. 

The [Set Dflt] button lets you save any combination of surface shading parameters as 
default settings. Press [Restore Dflt] to restore default conditions after adjusting the 
settings. After changing any of these parameters, click on [OK] to leave the dialog box 
then click on [Apply] to see the changes take effect. 

Presentation Settings: Range 

Selecting Range calls up the Range Settings dialog box.  This interacts with the rendering 
range settings and affects the display of density values and units in the range bar. 

Figure 101: The Range Settings dialog box. 

 

Range Axis Definition 
The levels are displayed in the range bar area of the window. Levels may be included or 
excluded by changing the width of the sliding bar or moving the slider along the range.  
Both gray levels or gray levels/calibrated values are shown in the status bar. 

Linear to levels -- uses gray level values. This is active for any image and the status bar 
shows either gray levels (if the images are not calibrated) or gray levels followed by 
calibrated values if a calibration applies.  

Linear to Calibrated values -- uses calibrated values and the status bar shows calibrated 
values followed by gray levels.  This radio button is “grayed” if the dataset does not 
include calibrated values.   
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Extrapolation -- allows you to use values outside the calibrated range. The checkbox 
toggles off/on between the established calibration curve and the extrapolation. The 
checkbox is “grayed” if cannot be extrapolated. 

The [Set Dflt] button lets you save any combination of Range Settings parameters as 
default settings. Press [Restore Dflt] to restore default conditions after adjusting the 
settings. After changing any of these parameters, click on [OK] to leave the dialog box 
then click on [Apply] to see the changes take effect. 

Presentation Settings: Density Visuals 

Selecting a new visuals file affects rendering methods that display densities. Click on 
[Load] to see a list of visuals files (i.e., look-up tables). Select the one you want then click 
on [OK] to close the dialog box. Click on [Apply] to see the visual applied to your image.  

Figure 102: The Visuals Settings dialog box. 

 

Any visuals file can be set as the default by clicking on the [Set Dflt.] button.  

Presentation Settings: Same Parameters 

If this menu option is selected, the same range settings apply when you choose different 
rendering types. This makes comparisons between different renderings much easier to 
understand. 

Presentation Settings: Same Transform 

If this menu option is selected, the same transform applies if you choose different 
rendering types. You can switch between the transform you created and the default. 

Presentation Settings: Status Bar 

This turns the status bar above the range indicator on or off.  

Window Arrangement 

The 3D Rendering Control window may be displayed in Vertical or Horizontal format. 
Vertical format lets you fit the 3D Rendering Control window inside the Sample window 
without obscuring the data table. 

The 3D Dataset Menu 
The 3D Dataset menu contains options for opening, saving, and processing 3D datasets.  It 
also lets you record then play cine loops, and create thumbnail sketches.  Some of the 
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menu options are not available until you interpolate a stack, or open a saved 3D dataset.  
The 3D dataset is saved with a *.3st file extension. 

Figure 103: The 3D Dataset menu showing the current dataset. 

 

Menu Options 

Open – Opens a saved 3D dataset.  It is easier to open a saved dataset rather than repeat 
the interpolation of the stack. To see the opened dataset, click on Apply in the 3D 
Rendering Control Window 

Add – Appends a 3D dataset to the system list.  A list of opened datasets appears at the 
bottom of the 3D Dataset menu, and the current dataset has a checkmark beside it.  To 
change the current dataset, just click on another one in the list. 

Save – Saves the current 3D datasets.  

Save As – Saves a file with a different filename so previously saved data are not over-
written. 

Close – Closes the current 3D dataset.  If you do not have any datasets open, this menu 
option is “grayed”.  

Close All – Closes all opened 3D dataset files. If you do not have any datasets open, this 
menu option is “grayed”. 

Cine loop – Options for creating and playing movie-like sequences of a rendered image 
(e.g., rotating back and forth). See below for details. 

Process – Applies an image processing filter to the 3D dataset. See below for details. 

Thumbnail and description – Create a compressed image of a rendered 3D dataset.  The 
image is displayed in the Open/Add 3D Dataset dialog box. See below for details. 

Processing 3D Datasets 

This opens a dialog box that contains processing filters that you can apply to density or 
structure data. The Process menu option is grayed out until you open a dataset. 
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Figure 104: The Process 3D Dataset dialog box showing a 3x3x3 Smoothing kernel. 

 

Smooth -- Smoothing applies a low pass filter to the 3D dataset. High frequency 
components are attenuated but low frequencies are not affected.  Larger kernels have a 
coarser effect. 

Median -- This replaces each pixel with the median value of surrounding pixels.  A 
median filter is similar to a smoothing filter, but feature edges are not as smooth. 

Kernel size -- Four pre-set sizes of kernel exist from 3x3x3 to 9x9x9. Click on the 
Up/Down arrows to step through the list. You cannot edit these kernels. 

Components -- You have to choose either or both of the following components for 
processing: 

Density -- Applies kernels to the density data. 

Structure -- Applies kernels to defined structure data. 

Click on [OK] to start the process.  Click on [Apply] in the 3D Rendering Control 
window to see the result. Save the 3D dataset, if you want to keep the processed data. 

Thumbnail and Description 

This menu option lets you create a “thumbnail sketch” and a description of the current 3D 
dataset. Thumbnails are compressed images that allow you to see the contents of a dataset 
without loading the entire file into memory.  You may find the addition of the thumbnail 
useful for quick identification of datasets.  

To create a thumbnail, click on the [Set Thumb] button. A compressed version of the 
current rendered image appears in the Thumbnail box.  Place the cursor in the 
Description box and type a brief note to describe the image.  Click on [OK] then open the 
3D Dataset menu and Save the thumbnail and description with the 3D dataset file.   

When you have created the thumbnail, the [Set Thumb] button becomes a [Replace 
Thumb] button.  Suppose you save the thumbnail, then create another rendering and want 
to replace the original image. Click on [Replace Thumb] and a thumbnail of the new 
rendered dataset appears in the dialog box.  If you want to keep the new thumbnail, you 
have to Save it again.  The Thumbnail option is “grayed” until you create a 3D dataset 
from a stack, or open a saved file. 
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Figure 105: The Set Rendered Thumbnail and Description dialog box. 

 

Cine Loops 
Cine loops display the rendered image in a dynamic way, which often gives a much better 
perception of the 3D structure. You can create many possible types of cine loops to show 
the effects of different degrees of rotation, position of the light source, cutting planes and 
density ranges.  In some cases, you can combine different types of loop, for example light 
source and rotation, and if none of these types is exactly what you want, you can create 
your own loop interactively with the User define option and the 3D Rendering Control 
window. 

To create or replay loops, select 3D Dataset > Cine Loop. The Cine Loop sub-menu 
appears (Figure 106). 

Note: The Record and Play multiple options will be disabled if you do not have a 3D 
dataset open. To play multiple loops, you must select the 4 channels per page 
Display Format. 

Figure 106: The Cine Loop sub-menu. 
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Recording Cine Loops 
To create a cine loop, chose Record from the Cine Loop sub-menu.  The Record Cine 
Loop dialog box appears (Figure 107). 

Figure 107: The Record Cine Loop dialog box. Rotation is the default type of cine loop. 

 

Types of Cine Loops 

In most cases you create a cine loop that rotates the 3D object, but other options are 
available. Click on the down arrow at the right of the Type box to see the list. The list will 
change depending on the type of rendering you choose and whether any cutting planes are 
active. 

We suggest that you use the [Test] button to try out a new cine loop, especially while you 
are learning.  Clicking [Test] will let you see how the loop applies to the transform 
indicator in the 3D Rendering Control window before you apply it to your dataset. 

Rotation Cine Loops 
The object rotates through an arc defined by the user.  Rotation may be full (360 degrees) 
or partial (<360 degrees). The smoothness of motion depends on the number of views and 
the step size.  You can define the number of views in the loop and the size of the step 
between each one.  Many views and small steps create a smooth loop, but these conditions 
are very demanding of system memory and may take some time to create. 

Cutting Planes Cine Loops 
Cutting planes loops show the effects of applying cutting planes to the 3D rendering 
dynamically. The cutting plane is applied at intervals determined by the step size and the 
image accumulates as the loop runs.  For example, if you are using 10 views to create a 
cutting plane loop in the X axis, each view will be 10% of the X axis dimension.  The 
effect is one of a series of slices being added together to produce the complete rendered 
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object. You can define the axis of a cutting plane individually, (e.g. create a loop cutting in 
X) or all axes simultaneously (cutting planes in X, Y and Z). 

Note: Cutting plane loops are not an option in the cine loop menu unless a Cutting 
Planes icon is selected. 

Light Source Cine Loops 
The light source moves with respect to the object. If the Rotation box is checked, the 
object rotates at 3o intervals in the Y axis as the light source moves. 

Density Range Cine Loops 
This option creates a loop by mapping the density ranges in the 3D dataset. It is easiest to 
understand if you use the test function first to see what happens when you create a density 
range cine loop.  Keep the number of views set at 10. The steps between views are now 
measured in levels rather than in degrees. Set the range slider to mid range values, say 
100-150. Click on test and the slider steps through the range at intervals of 15 levels. 

If there is a check mark in the Rotation box, you can create combined density and rotation 
loops. The object rotates at 3o intervals in the Y axis. 

Resolution Options 

Resolution refers to the size of the rendered images. 

High -- High resolution means a quarter screen display, 640x512 pixels. 

Low -- the image size is 320x256 pixels. 

MNFV -- Maximum Number of Fast Views is the storage capacity of the frame buffer on 
the imaging board and is linked to the Resolution setting.  If there are more views in the 
loop than the capacity of the buffer, the excess views are stored in host memory.  This 
makes the cine loop playback slower. 

No. of Views 

The number of “still” frames linked together to produce the cine loop. The number of 
views must be greater than 1. 

Range Options 

Full -- Creates a cine loop using the full range defined by the number of possible views. 
For example, a full range rotation loop shows movement through 360o. 

Rotation  Cutting Planes Light Source Density Range 

360o 100% 120 o/360o Full dynamic range  

Partial -- Creates a cine loop defined by the number of views and the step size (interval) 
between each view.  The product of number of views x step size must be less than the full 
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range or warnings appear on the display.  If this happens, change either the number of 
views or the step size. 

Step Options 

Sets the interval between each view in a partial range loop. Step sizes are indicated in 
degrees for Rotation and Light source cine loops, in percentage for Cutting Planes loops 
and in levels for Density loops. With Full range selected, the number in the Step: entry 
field is grayed. You cannot enter any values, but the grayed numbers change as you change 
the number of views. 

Direction Options  

The number of Direction field icons in the Cine Loop dialog boxes varies according to the 
type of cine loop chosen. There are no direction options for Cutting Plane cine loops. 

Rotation Cine Loops 

 Shows the rendered image rotating in a horizontal plane. 

  Shows the rendered image rotating in a vertical plane. 

  Shows the rendered image rotating in a diagonal plane from upper left to lower 
right. 

  Shows the rendered image rotating in a diagonal plane from upper right to lower 
left. 

Light Source Cine Loops 
The Light source cine loop dialog box displays six direction fields. If the light source is 
located at the center of the transform indicator, only the first four direction fields appear. 

 Light source rotates around rendered object(s) in a horizontal plane. 

  Light source rotates around rendered object(s) in a vertical plane. 

  Light source rotates around rendered object(s) in a diagonal plane from upper left 
to lower right. 

  Light source rotates around rendered object(s) in a diagonal plane from upper 
right to lower left. 
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 The light source rotates around the center of the transform.  The + shows the 
center of rotation and the red square shows the light source. 

 The light source rocks through an arc, defined by the center of the transform and 
the current light source position.  The limits are defined by the product of number 
of steps x degrees. The midpoint of the arc is indicated by the position of the + 
and the red square shows the light source.  

For example, if you create a loop of 10 views at 9 o  each, the light source will 
rock through an arc 45 o either side of the midpoint.  Maximum limits of arc are 
120 o (60 o either side of the midpoint for a full loop). 

To create an arc, drag the red star away from the center of the transform then click 
on this icon.   

Density Range Cine Loops 

  Each view in the loop is created by moving the rendered range along the scale of   
gray levels. Each view is separated by the number of levels in the step.  

   Each view in the loop is created by moving the lower end of the rendered range 
along the scale of gray levels. The upper end of the range remains fixed, and each 
view is separated by the number of levels in the step. 

  Each view in the loop is created by moving the upper end of the rendered range     
along the scale of  gray levels. The lower end of the range remains fixed, and each 
view is separated by the number of levels in the step. 

  Each view in the loop is created by moving both ends of the rendered range along 
the scale of gray levels. Each view is separated by the number of levels in the step. 

User Defined Cine Loops  

This lets you record a cine loop interactively from the 3D Rendering Control window.  
You define the settings for the start and end views, then M3D uses these parameters to 
interpolate the n-2 intermediate views. 
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Figure 108: The Create Cine Loop dialog box for User defined cine loops.  

 

For example, suppose you decided to create a loop that showed the effects of rotation, 
changing the position of the light source and applying cutting planes, in 10 views.   

The procedure for recording the cine loop is very simple: 

1. Click on one of the Cutting plane icons, then open the Record cine loop menu 
option and select User define as the cine loop type.  

2. Select the Resolution and enter the Number of views. 

3. Use the Rotation cube to set the transform indicator into position for the first 
view then set the initial positions of the light source and any cutting planes. 

4. Move the cursor to Cine Loop Start and click on [Record].  

5. Now adjust the position of the transform indicator, position of light source and 
cutting planes for the last view. 

6. Move the cursor to Cine Loop End and click on [Record]. 

7. Click on the [Show ]buttons in the Start and End fields to see the parameters set 
for these views. 

8. Click on [Test].  The interpolated views between Start and End are shown in the 
transform indicator.  

9. Click on [OK] to create the cine loop. 
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Figure 109: The start (A) and end (B) views of a user defined cine loop displaying 
rotation, change in position of the light source, and the application of cutting planes. 

A      B 

   

Playing Single Cine Loops  
This option plays a single cine-loop in one channel. When you choose 3D Dataset > Cine 
Loop > Play single, the Play Cine Loop dialog box appears (Figure 110). 

The Play Cine Loop dialog box contains the name of the loop (if it has been saved), a 
description of the loop type, and loop attributes such as resolution, number of views, range 
and loop direction. The Play Options area contains a slider control and four buttons that 
control playback. 

Figure 110: The Play Cine Loop dialog box. 

 

The Interval slider control changes the time interval between each view and consequently, 
affects the replay speed of the cine loop.  The interval between views is adjustable from 30 
msec to 2.93 sec. 

 This button starts the loop running in continuous mode. The loop plays until you 
stop it. 
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 Moves the loop forward 1 view at a time. 

 Moves the loop backward 1 view at a time. 

 Stops the loop. 

The [Load], [Save] and [Done] buttons are not active until you stop the cine loop. The 
Help button is active in any mode except continuous play. 

Load -- Calls up the Load Cine Loop File dialog box (). If you click on [Load] before 
saving the current cine loop, M3D prompts you to save it before loading another loop. 

Save -- Saves the cine loop. Cine loops are saved with *.cnl file extensions. 

Done -- Closes the dialog box.  If you click on [Done] before saving the cine loop, M3D 
prompts you to save it before closing the dialog box. 

Figure 111: The Load Cine Loop File dialog box. This contains a list of saved cine loops. 
It shows the display type, loop type, number of views and resolution. When you highlight a 
filename, a view from the loop appears in the small frame.  

 

Playing Multiple Cine Loops 
This option replays up to four different cine loops in four channels.  It is not active until 
you select 4 channels per page in the Settings > Display format menu. 
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Figure 112: The Play Multiple Cine Loops dialog box with four loops created from the 
sample dataset.  The quadrants in the dialog box correspond to the 4 channels on the 
image monitor. 

 

The System Cine Loop is the loop played by M3D during the last cine loop session.  It is 
stored in the system’s memory and overwritten by the loop played in the current session. 

Load -- Clicking on [Load] calls up the Load Cine Loop File dialog box (Figure 111). 

Play -- If there is a mark in this checkbox, the selected loop is played in the corresponding 
quadrant on the image monitor. 

Interval -- The Interval slider control changes the time interval between each view and 
consequently, affects the replay speed of the cine loop.  The interval between views is 
adjustable from 30 msec to 2.93 sec.  In multiple loop mode, the slider affects all of the 
selected loops simultaneously. 

 This button starts the selected loops running in continuous mode. 

 Stops the loops. 

3D Data Measurement 
M3D has a dedicated set of 3D Sample tools accessible in the 3D Rendering Control 
window.  

Note: The 3D Sample tools do not work with the density rendering types.  If you 
want to make measurements of the sample dataset, apply the Solid Surface 
rendering type first.  
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Figure 113: The 3D Sample toolbox. 

 

3D Sample Tools 

 3D Pointer 
The 3D Pointer tool measures the volume (3D Volume) and surface area (3D Surface) of 
any object in the rendered image. Move the cursor onto the rendered image and click on an 
object. The 3D Volume and 3D Surface data are reported in the data table. If the dataset 
contains no spatial calibrations, volume is expressed in ‘voxels’ and surface area in 
‘pixels’. 

 3D Full Volume Scan 
The 3D Full Volume Scan tool measures the total volume and surface area of all 
structures rendered in the same color. To select a structure, click the Full Volume Scan 
tool on it.  The volume and surface area of all the targets are reported in the data table. 

 3D Line 

The 3D Line tool measures straight-line distances between points on the surface of a 
single rendered structure.  Press the left button and move the mouse to draw a rubber band 
line.  The 3D Length data are reported in the data table. 

 3D Length: Trace 
The 3D Length: Trace tool measures length of line between two points on a single object, 
as drawn.  Press the left button and move the mouse to sketch a line.  Release the button to 
sample.  

 3D Length: Connect 
The 3D Length:Connect tool measures length of line along a series of connected points 
on a single object as drawn.  Press the left button to define points and M3D connects the 
points as you go along.  Click the right button to back up a point.  Double-click the last 
point to obtain a measure.   
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